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INTRODUCTION

This guide is for individuals configuring a database for WinSPC and
installing and configuring WinSPC on client stations. It consists of
procedures to accomplish these tasks for the following database
Servers:

Microsoft SQL Server 2005
Microsoft SQL Server 2005 Express
Microsoft SQL Server 2008
Microsoft SQL Server 2008 Express
Oracle 10g

Oracle 11g

The four Microsoft SQL Server editions are all dealt with in Chapter
1: Microsoft SQL Server 2005/2008. A free download of Microsoft
SQL Server 2005 Express as well as Microsoft SQL Server 2008
Express are available at: www.winspc.com/downloads. (To access this
web page, enter the username and password included in the e-mail
notifying you of the release of WinSPC Version 8.0. If you did not
receive an e-mail notification, contact the DataNet Quality Systems
Product Support Help Desk at 248-447-0140.)

WInSPC is certified to run in a traditional client/server environment
and a Microsoft Terminal Services environment. The content in this
guide applies to both except where marked by a Terminal Services
marker, in which case the content applies uniquely to a Microsoft
Terminal Services environment. The first appearance of the Terminal
Services marker is to the right of the following paragraph.

When an implementation involves a Microsoft Terminal Services (
environment, WinSPC must be installed on the Microsoft Terminal WL
Services server. If the implementation does not also involve a - —

client/server environment, make the Microsoft Terminal Services
Terminal Services
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server your first client. (First client simply refers to the first computer
on which WinSPC is installed.) If the implementation also involves a
client/server environment, it does not matter whether you make the
Microsoft Terminal Services server the first client or an additional
client. (Additional client means any computer on which WinSPC is
installed other than the first client.) Electing to make the Microsoft
Terminal Services server the first client means that the procedure for
installing WinSPC on the Microsoft Terminal Services server is the
procedure detailed in Phase 2 of the chapter specific to the database
server being used in your implementation. Electing to make the
Microsoft Terminal Services server an additional client means that the
procedure for installing WinSPC on the Microsoft Terminal Services
server is the procedure detailed in Chapter 5: Additional Client
Installs and Configurations.

For WinSPC’s hardware requirements and recommended platforms,
see Appendix G: Hardware Requirements and Recommended
Platforms.

DataNet Quality Systems wants your installation and configuration to
be a positive experience. Please do not hesitate to contact our Product
Support Help Desk at (248)-447-0140 if you have questions
concerning any of the information in this guide.
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CHAPTER 1: MICROSOFT SQL SERVER 2005/2008

WIinSPC is certified to run on the following editions of Microsoft SQL
Server: Microsoft SQL Server 2005 Express, Microsoft SQL Server 2005,
Microsoft SQL Server 2008 Express and Microsoft SQL Server 2008. This
chapter applies to each of these editions.

The procedure to configure any of these four editions for use with WinSPC is
nearly identical to that of the other three. Consequently, where images of
Microsoft SQL Server prompts are used for illustration, they are exclusively
from Microsoft SQL Server 2005 Express. In addition, where the text of this
chapter applies to all four editions equally, edition-specific information is
omitted in favor of generic titles such as Microsoft SQL Server or SQL Server
Management Studio.

ASSUMPTIONS

The instructions in this chapter are based on the following
assumptions:

= Microsoft SQL Server is installed on your database server
machine.

= An instance of Microsoft SQL Server has been created for
WinSPC and is running. (This instance may be named or
unnamed.)

= During the creation of this instance, the authentication mode
selected was Mixed Mode (Windows Authentication and SQL
Server Authentication). (WinSPC will not function if the default
Windows Authentication Mode was accepted.)

Installation and Configuration Guide ‘ ‘
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Chapter 1: Microsoft SQL Server 2005/2008

= The management and configuration tools appropriate to your
edition of Microsoft SQL Server are installed on your database
server machine. At a minimum, these include SQL Server
Management Studio and SQL Server Configuration Manager.

= Other than the Mixed Mode of authentication and where an
exception is clearly noted, the default values presented by your
Microsoft SQL Server edition during the setup process were
accepted without modification.

= Firewalls between your database server and the client stations to be
used for WinSPC are configured to permit database traffic.

= For implementations employing a Microsoft Terminal Services
environment, Microsoft Terminal Services is properly installed and
configured on the server designated as your Microsoft Terminal
Services server and the client stations that will run WinSPC on this
Terminal Services server can successfully establish a Remote Desktop Protocol
(RDP) connection to the server.

= The operating system of your database server machine is Windows
Server 2003 or Windows Server 2008.

= The operating system of the client machines to be used for
WinSPC is Windows 7, Windows Vista Business or Windows XP
Pro. (Images of client machines included in this guide are from
Vista Business.)

NOTE: If a default value was modified during the setup Microsoft
SQL Server or an operating system is different from that
stated here, adapt the instructions in this guide as needed to
accommodate the modified value or differing operating
system.
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Chapter 1: Microsoft SQL Server 2005/2008

SERVER CONFIGURATION

Establish a Server Connection

1.

2.

On the database server machine, launch SQL Server
Management Studio, the default path for which is Start > All
Programs > Microsoft SQL Server> SQL Server Management
Studio.

In the Connect to Server prompt that appears:
a. At Server Type, accept the Database Engine default.

b. At Server name, if a name is not displayed or the name
displayed is not the name of the machine on which the instance
of Microsoft SQL Server to be used for WinSPC is created,
select the correct name from the dropdown list. Depending on
your edition of Microsoft SQL Server and the options selected
during this edition’s setup, the instance for your
implementation may be named or unnamed. If your instance is
named, the correct name for this Server name field consists of
a combination of the server name and the instance name (e.g.
TESTSERVER\SQLEXPRESS). If your instance is unnamed,
the correct name for this Server name field consists of the
server name alone (e.g. TESTSERVER). In the event the server
name displayed is incorrect and the dropdown list does not
contain the correct name:

i. From the Server name dropdown list, select <Browse for
more...>.

ii. Inthe Browse for Servers prompt, click the Network
Servers tab. This automatically initiates a search for
servers on your network.

Phase 1 of 4
[ I
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Chapter 1: Microsoft SQL Server 2005/2008

C.
d.
e
f

iii. When the search completes, expand Database Engine and
single-click the desired server name or server
name\instance name combination.

iv. Click OK.

At Authentication, select SQL Server Authentication.
At Login, enter sa.
At Password, enter the password assigned to the sa login.
Click Connect.
x
gicmsu:ui S fﬁ' [ ”ﬁumnﬁnws Server System
QL Server 2005
Server type: IDatabase E ngine j
Server name: ITESTSEHVEH'&SDLEXF‘HESS j
Authenticatiomn: ISII!L Server Authentication j
Logir: Isa j
Beerad) Ixxxmxx
[T Remember paszword
Connect I Cancel | Help Optiong >
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Chapter 1: Microsoft SQL Server 2005/2008

NOTE: If the Connect to Server prompt is not displayed, click
File > New > Database Engine Query in Microsoft
SQL Server Management Studio and complete the
preceding substeps in the Connect to Database Engine

prompt.

Installation and Configuration Guide ‘ ‘ 7



Chapter 1: Microsoft SQL Server 2005/2008

Create a Database

DataNet Quality Systems recommends that a new database be created
for the exclusive use of WinSPC. Use of a WinSPC database by other
applications is not tested and consequently not certified by DataNet.

1. Inthe Object Explorer (i.e. the left pane) of Microsoft SQL
Server Management Studio, right-click Databases and, from the
shortcut menu, select New Database.

File Edit iew Tools ‘Window  Community  Help

Dewouery | [y | [ | SVl H @ BB B R & o

!}:. Microsoft SQL Server Management Studio Express - |EI|5|

Object Explorer Wil | - Summary - ¥

@l @l R
-i# -E!:-: E I_-"!i E : e
= [ {) TESTSERVER|SOLEXPRESS (SGL Server 9.0
[ RC atabases -1 -
[ Security |_ Mew Database, .. | abases
[ Server Ob ERYERISOL 1 Ikemnfs)
[ Replication attach...
[ Managems Restore Database..,
Restore Files and Filegroups. .. I
atabases
Reports r
Refresh
Jl | i

Feady
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Chapter 1: Microsoft SQL Server 2005/2008

2.

In the New Database prompt, at Database name, create and enter

a name for the database. (The recommended database name is

WiInSPC.)
i0lx]
Sleclapage 6 Script + [ Help
A General
|44 Dpti -
ﬁi .D 1ans [ratabase name: IWlnSF’E
gﬁ Filegroups
Dwner: |<default> |
= Use fulltest indesing
[ atabase files:
Logical Mame | File Type | Filegroup | Initial Size [ME] | Autogrowth
WinSPC Data PRIMARY 2 By 1 MB, unrestricted growth
WwinSPC_log Log Mot Applicable 1 By 10 percent, unrestricted growth
Server
TESTSERWERMSOLEXPRESS
Connection:
sa
g} “iew connection properties
Feady d I I _’I
Add | Bemaye |
ok I Cancel |
4
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Chapter 1: Microsoft SQL Server 2005/2008

3. If you are configuring a full, as opposed to express, version of
Microsoft SQL Server, you may want to consider changing the
default Recovery Model from Full to Simple. This helps prevent
Microsoft SQL Server’s transaction log from growing to a point
where it interferes with database performance. To change the
Recovery Model to Simple, under Select a page, click Options

and, at Recovery model select Simple.

F New Database -10] x|
Sleclapa S Script ~ F_J] Help
& General
44 Dptions .
_,%;. Filegroups Lollation: |<server default> j
Fecovery model: Simple j

Connectio

Server
TESTSERWVERMSOLEXPRESS

Connection:
sa

3 View connection properties

Feady

Compatibility Jevel:

DOther options;
E=E
B Automatic I
Auto Close False
Auto Create Statistics True
Auta Shrink Falze
Auto Update Statistics True
Auto Update Statistics Asynchronously Falzse
El Cursor
Cloge Cursor on Commit Enabled False
Default Cursor GLOBAL
B Miscellaneous
ANSIMULL Default False
ANSIMULLS Enabled False
AMSI Padding Enabled Falzse
AMSI W amings Enabled Falzse —
Arithmetic Abort Enabled False
Concatenate Mull Yields Mul False
Crozz-databaze Ownership Chaining Enabled | Falze
[ ate Cormelation Optimization Enabled Falze
Murmeric Bound-abaort False
Parameterization Simple -
ANSI NULL Default

oK I Cancel |

4
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Chapter 1: Microsoft SQL Server 2005/2008

NOTE: According to Microsoft, with the Recovery Model set to
Simple, a database can only be recovered to the time of
the most recent backup. This means that data captured
between the most recent backup and a failure which
necessitates a recovery is lost. If this is an unacceptable
risk for your organization, use the Full or Bulk-logged
option and follow Microsoft’s recommendations to control
the size of your transaction log.

4. Click the New Database prompt’s OK button.

Installation and Configuration Guide ‘ ‘ 11



Chapter 1: Microsoft SQL Server 2005/2008

Create a Server Login

1. Inthe Object Explorer, right-click the Security folder and select
New > Login.

I__}:. Microsoft SOL Server Management Studio Express - |EI|5|

File Edit Wiew Tools indow  Community Help

Dewouery | |3 (Sl H & [ B BB F g

Chiject Explarer > 3 X /SM - %
VX e T @ @2 T EE
B | {) TESTSERVER|SQLEXPRESS (SGL Server 9.0
[ Databases e .
g cecurity D SECLII'It‘,r'
[ Server |_ M 2 m Login... |R'||5Q|_ 3 Itemis)
[ Replica . I
£ Managd Reports Y Credential,..
Refresh Mame I
[ Lagins
[ 5erver Roles
[ Credentials
J | =
Ready y

(The Security folder referred to here is the one in the root level of
the folder for the server or server\instance you are configuring, not
a Security sub-folder within a database folder under the root
Databases folder.)

12 ‘ ‘Insta//at/on and Configuration Guide



Chapter 1: Microsoft SQL Server 2005/2008

2. Inthe Login - New prompt:

a. At Login name, create and enter a name for the login. (The
recommended name is JOHNDOE.)

b. Select SQL Server authentication.

c. At Password, create and enter a sufficiently strong password
for the login.

d. At Confirm password, reenter the password.

NOTE: The user name and password entered here will be used by
Microsoft SQL Server to authentic WinSPC client
stations and allow authenticated stations access to the
WinSPC database. This user name and password
combination is not directly used by WinSPC users.
WIinSPC users will, later, be assigned individual user IDs
and passwords and will use these individual 1Ds and
passwords to log into the WinSPC application on
WinSPC client stations.

e. Uncheck the Enforce password policy check box.

Installation and Configuration Guide ‘ ‘ 13



Chapter 1: Microsoft SQL Server 2005/2008

f. At Default database, select WinSPC.

] ' ‘Windows authentication
1A Status

i+ SOL Server authentication

-0l x|
Sleclapage S Script - m_:‘] Help
12 General
[l
ﬁ‘ erverHoIgs (P JOHNDOE Search...
j’ Uszer b apping
147 Securables

Password: |uuou.

LConfirn pazzward: I"uoou

" Enforce password policy
™| Enforce password expiration

™| Wser must change password at nest lagin

! Mapped to certifizate

Certificate name: I

| tapped to asymmetic key

Koy e |
Server
TESTSERVERNSOLEXPRESS Default database:
Connection: Default language: I <defaulty
a

_"'Qj “igw connection properties

Feady

oK I Cancel |

4
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Chapter 1: Microsoft SQL Server 2005/2008

Under Select a page (top left pane), single-click User Mapping

and then, in the right portion of the prompt:

a. Under Users mapped to this login, in the Map column, check
the check box for the newly created WinSPC database.

b. Under Database role membership for: <Database Name>,

check the db_owner check box.

c. Click OK.
-i0jx]
Seeclapa S Script - u Help
A4 General
e ol
- Uz:;el\;a;p?:g Uszers mapped to this login:
4 Securables Map | [ atabase | User | Default Schema
1A Status - master
— model
Il msdb
tempdb
WinSPC JOHNDOE [
[T Guest account enabled for SWinSPE
Databasze role membership for: *WinSPC
[[] db_accessadmin
Server [ db_backupoperator
TESTSERVERVSOLEXPRESS | | dh datareader
) [ db_datawriter
Connection: [] db_ddladmin
3a 0d
“igw connection properties [ d
&+ 7k b
[1d
Wl public
Ready

o]

Cancel |

4
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Chapter 1: Microsoft SQL Server 2005/2008

Configure the SQL Server Browser Service and Enable a Network
Protocol

1. Without exiting Microsoft SQL Server Management Studio,
launch SQL Server Configuration Manager, the default path for
which is Start > All Programs > Microsoft SQL Server >
Configuration Tools > SQL Server Configuration Manager.

2. If the Microsoft SQL Server instance you are working with is not a
named instance, go to step 3. If the instance you are working with
is a named instance, configure the SQL Server Browser service.
(If you don’t know whether the instance is named or unnamed,
assume it is named.) To configure the SQL Server Browser
service:

a. In the left pane of SQL Server Configuration Manager, click
SQL Server Services.

?‘,’ SQL Server Configuration Manager - |I:I|5|

File  Action View Help

= B[R 2

‘@ AL Server Configuration Manager (Local) Marne I State
----- ﬁ S0L Server 2005 Services @SQL Server Browser Stopped
H- B SGL Server 2005 Mebwark Canfiguration 5L Server (SOLEXPRESS)  Running
Ll

-5 S0L Mative Client Configuration
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Chapter 1: Microsoft SQL Server 2005/2008

In the right pane, right-click SQL Server Browser and select

Properties.

In the SQL Server Browser Properties prompt, click the

Service tab.

On this tab, to the right of Start Mode, click Disabled and

select Automatic.

S0L Server Browser Properties ilil

Logon  Service |.ﬁ.d'-.fann:ed I

H General
Binarw Path "c:\Program FilesiMicrosoft S0L Ser
Error Control 1
Exit Code 1077
Hask Mame TESTSERVER.
Mame SOL Server Browser
Process ID 0
SOL Service Type SOL Browser
Start Mode Disabled ﬂ
State stomatic |
Disabled
anual
Start Mode
The start rode of this service.
Ik I Zancel Apply Help |
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Chapter 1: Microsoft SQL Server 2005/2008

e. Click the Apply button.
f. Click the Log On tab and on this tab click the Start button.

S0QL 5erver Browser Properties ﬂﬂ

Log On |Service I Advanced I

Log on as:

INetwnrk SErvice j

£~ This account:

Accounk MNarme: I Erawse |

Passwiord: I kst ok ke
Confirm passwords I kbR sk sk
Setvice skaktus: Stopped
Skart | Shop | Fause | Restark |

Ik I Zancel | Ay | Help

g. Allow the progress bar that appears to complete.
h. Click OK.

18 ‘ ‘Insta//at/on and Configuration Guide



Chapter 1: Microsoft SQL Server 2005/2008

3. Enable a network protocol. To do this:

a.

In the left pane of SQL Server Configuration Manager,
expand SQL Server Network Configuration and single-click
Protocols for <SERVER OR INSTANCE NAME>.

?}' SQL Server Configuration Manager - |EI|£|

File Action View Help

€2 B8R RB|2

‘@ a0L Server Configuration Manager (Local) Pratocal Mame | Skatus
----- SOL Server 2005 Services % Shared Memary Enabled
EI . S0L Server 2005 Metwark Configuration | | %= named Pipes Disabled
= ciccols for SOLEvPRES: WTCRIP Disabled
! S0L Mative Client Configuration VA Disahled
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Chapter 1: Microsoft SQL Server 2005/2008

b. In the right pane, right-click either TCP/IP or Named Pipes
and click Enable. (WinSPC works with either of these options.
If you are unsure of which option to choose, consult your
network administrator.)

?}' SQL Server Configuration Manager - |EI|5|

File  Actiomn Yiew Help

= | 0FE 2

@ QL Server Configuration Manager (Local) Prokocol Mame | Skatus
----- E 30L Server 2005 Services % shared Memory Enabled
- 5. SQL Server 2005 Metwark Canfiguration | | %= named Pipes Disabled
4= Protocols for SQLEXPRESS
w8 S0L Mative Client Configuration S IA

Disable
Properties

Help

a | H

|Ena|:u|e selected protocal, | |

c. Inthe warning indicating that changes will not take effect until
the service is stopped and restarted, click OK.
warning X

\:!J) any changes made will be saved; howewer, they will not take effect until the service is stopped and restarted.

d. Close SQL Server Configuration Manager.
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Chapter 1: Microsoft SQL Server 2005/2008

e. In Microsoft SQL Server Management Studio, right-click
the server you’ve been configuring and select Stop.

.,;. Microsoft SQL Server Management Studio Express - |I:I|£|

File Edit Mew Tools ‘Wndow  Community  Help
Drewouery | [y | [ | Sovel H @ | B 2 B R = |

Object Explorer -3 X /Sm * X
BLBe TE 2 F & Y EE]

ERNY s ILEXPF, ) &t 9,0
[d Databases Connect...
02 socrty Gt || TESTSERVER)
[ Server Objects = . TESTSERVERISGL 5 Ttemis)
[ Replication Reqister...
[ Management
Mew Query
e |
Stark I Databases
Stop Security
Server Objects
Pause Il Replication
Resume Il Management:
Reskart
Reports r
l
Refresh
Ready y
Properties

f. Inthe message box that appears, click Yes to confirm you want
to stop the service.

Microsoft SQL Server Management Studio Express

:() Are vou sure you want to stop the MSSQLESQLERPRESS service on TESTSERVER?
-
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Chapter 1: Microsoft SQL Server 2005/2008

g. When the message box closes, right-click the server again and
select Start.

'»:f Microsoft SQL Server Management Studio Express - |EI|5|

File Edit Miew Tools ‘Window  Community  Help
Pewouery |y |3 | G H A BERES
Object Explorer - X /jm * X

=R TE
1 Databases Conneck. .. j \
e iy TESTSERVER
. jsConnec
|1 Server Ohjects = TESTSERVERISOL 5 Itemis)
[ Replication Register...
[ Managerent
il
e ety I I
Stark |] Databases
Security
Sk
= l Server Objects
Pause l Replication
Resume W Management
Restart
Reparts 3
|
Refresh
E— efres Y
Propetties
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Chapter 1: Microsoft SQL Server 2005/2008

In the message box that appears, click Yes to confirm you want
to start the service.

Microsoft SOL Server Management Studio

@ Are wou sure you want ko start the MSSOLSERVER service on TESTSERVER?

EE es Mo

Click File > Exit to close Microsoft SQL Server
Management Studio.

THIS COMPLETES PHASE 1 OF 4.
GO TO THE NEXT PAGE AND COMPLETE PHASE 2.
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Chapter 1: Microsoft SQL Server 2005/2008

Phase 2 of 4
N

‘A

Terminal Services

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS)

This section concerns the installation and configuration of WinSPC on

the first WinSPC client. The first WinSPC client refers to the first

computer on which you want to install WinSPC. This computer can be

any computer on your network.

If your implementation employs Microsoft Terminal Services, see the
discussion on page 1 of this guide for direction on whether to make
your first client the Microsoft Terminal Services server or another
computer.

1. Create a folder on a network file server accessible by all client
stations that will run WinSPC. This folder’s primary purpose is to
facilitate the installation and configuration of WinSPC on all

clients other than the first client. (The recommended name for this

folder is WinSPCRemote.)

2. Share this folder and grant domain administrators at least the
minimum required permissions to it. For file servers running
Windows Server 2003, the minimum Share permissions are
Change and the minimum Security permissions are Modify. For
file servers running Windows Server 2008, the minimum Share
permissions are Contributor and the minimum Security
permissions are Modify. (For a procedure on granting Share or
Security permissions, see Appendix D: Granting Share and
Security Permissions.)

NOTE: If your WinSPC implementation is part of a workgroup
rather than a domain, grant these minimum permissions
to the local administrator who will install and configure
WIinSPC on the first WinSPC client.

24 ‘ ‘Insta//at/on and Configuration Guide



Chapter 1: Microsoft SQL Server 2005/2008

3. Log into Windows on the first WinSPC client as a domain
administrator who also has local administrator privileges.

NOTE: |If the first WinSPC client is part of a workgroup instead
of a domain, log in as a local administrator.

4. If the operating system of the first client is Windows 7 or Vista,
disable User Account Control (UAC). Refer to Appendix H for
instructions on doing this.

5. If you downloaded Install.exe from winspc.com/downloads:

a. Transfer this file to the first WinSPC client if it was
downloaded to a different computer.

b. Double-click the file.

c. If an Open File — Security Warning prompt appears, click
Run.

d. Gotostep?7.
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Chapter 1: Microsoft SQL Server 2005/2008

6. If you have the WinSPC CD (whether as a result of receiving it
from DataNet Quality Systems or burning it from the WinSPC.iso
file at winspc.com/downloads) and you did not complete the
preceding step:

a. Insert and run the CD.

b. On the WinSPC Version 8.0 setup prompt that appears, click
Install or Upgrade.

WI NSPC. Version 8.0

STATISTICAL PROCESS CONTROL

FA. What's New
FA. ReadMe

v., Installation & Configuration Guide

W) Upgrade Instructions Install or Upgrade

Need Help? Dial 866.4WINSPC or 248.447.0140 www.winspc.com

c. Gotostep?7.
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7. Complete the WinSPC Installation Wizard.

NOTE: The prompts of this wizard are intended to be self-
explanatory. Consequently, they are not detailed here. If
you have a question about a prompt or want to be directed
step-by-step through the wizard, see Appendix A: The
WinSPC Installation Wizard.

8. Complete Appendix B: Installing NJWin for an Asian
Language if the first client will need to run WinSPC in an Asian
language or you would like to run the WinSPC Configuration
Wizard in an Asian language. (The WinSPC Configuration Wizard
is the tool you will use next. As its name implies, it is the tool used
to configure WinSPC.)

9. If you installed WinSPC from a CD, exit the WinSPC Version 8.0
setup prompt by clicking Close in the upper right corner and
remove the CD from the CD-ROM drive.

10. Click Start > All Programs > WinSPC > WinSPC. This
launches the WinSPC Configuration Wizard.
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11. On the Language prompt, from the Select language list, choose a
language and click Next.

Win5PC Configuration Wizard

Language

Select lanquange:

IF the language selection vou prefer does not appear on
thiz goreen, contact pour zales representative for
infarmation on purchasing language installation software,

< Back M et = Cancel

NOTE: The language selected here is the language in which the
remainder of the WinSPC Configuration Wizard will run.
It also becomes the system-wide default language for
WIinSPC. (This default language can be changed at any
time following the completion of the WinSPC
Configuration Wizard. Once the configuration of the first
WinSPC client is complete, you can see the WinSPC
Help for more information on default languages.)
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Chapter 1: Microsoft SQL Server 2005/2008

12. On the Database Server Type prompt, select your Microsoft
SQL Server edition and click Next.

WinSPC Configuration Wizard E

D atabase Server Type

MNSPC Micrazaft SOL Server 2005

bicrozoft SOL Server 2005 Express
Microsoft SQL Server 2003
Microsoft SOL Server 2008 Express
Oracle Databasze 10g

Qracle Databaze 11g

< Back M et = Cancel
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13. On the Microsoft SQL Server Settings prompt:

a. At Machine Name, if the instance of Microsoft SQL Server
designated for WinSPC is a named instance, enter the name of
the machine on which the instance is created and the name of
the instance, separating the two by a backslash (e.g.
Testserver\SQLEXxpress). If the instance is an unnamed
instance, enter the server name only. If you do not know
whether the instance is named or unnamed or if you know the
instance is named but are unsure of the name used, contact the
server administrator.

b. At Database Name, enter the database name you chose in step
2 of this chapter’s Create a Database section.

c. Click Next.

WinSPC Configuration Wizard

Microzoft SAL Server Settings

Enter the machine name of your Microgoft SOL Server,
and the name of vour YWinSPC databaze.

b achine M ame:

ITestsewer"-.S LILEwpress ;I
[e.0.. kain]

D atabaze Mame:
[winSPC

[e.a.. WinSPC)

< Back

Cancel |
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14. On the Database Server Log In prompt, enter the server User
Name and Password created in step 2 of this chapter’s Create a
Server Login section and click Next.

Win5PC Configuration Wizard E |

Database Server Log In

l
WINSFC Enter the uzer name and passward that pou want

FRATIFTICAL FROCERS CONTROL WiNSPC to uge when logging into your databaze server.

IJzer Mame:

JOHMDOE
[e.g.. JOHMDOE]

Pazsword:

Ixxxxxxxx

[e.g.. paszword]

< Back Meut » Cancel
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15. On the Database Communications Test prompt, click Next.

WinSPC Configuration Wizard =™

D atabase Communications Test

The link. to your databaze server will now be tested. |f
evernthing iz zet up comectly, then this will only take a few
geconds. |f there iz a problem, then thiz could take a
couple of minutes.,

< Back

Cancel |

If you get a Database Communications Error indicating there is
an invalid connection string attribute, the communication test
failed. The most likely causes of the failure and their remedies are:

= The database server login was entered incorrectly. To remedy
this, click the Back button two times and re-enter the user
name and password, ensuring you have the correct user name
and password and that these are spelled correctly. Also, since
passwords are case sensitive, ensure appropriate capitalization
is used for the password. Once you have re-entered the login,
click Next and advance through the WinSPC Configuration
Wizard again, verifying the information on each prompt as you
do.
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= The machine name, instance name or database name was
entered incorrectly. To remedy this, click the Back button
three times and re-enter the machine name, instance name (if
you are working with a named instance) and database name,
ensuring you have the correct names and that these are spelled
correctly. Also, when entering an instance name, ensure it is
properly separated from the machine name by a backslash (e.g.
Testserver\SQLEXxpress.) Once you have re-entered the
name(s), click Next and advance through the WinSPC
Configuration Wizard again, verifying the information on each
prompt as you do.

= The instance being used for WinSPC is a named instance but
the SQL Server Browser service is not configured. To remedy
this, complete steps 1 and 2 of the Configure the SQL Server
Browser Service and Enable a Network Protocol section
earlier in this chapter, then click the Back button in the
WinSPC Configuration Wizard once and try the database
communications test again.

= A network protocol has not been enabled. To remedy this,
repeat steps 1 and 3 of the Configure the SQL Server
Browser Service and Enable a Network Protocol section
earlier in this chapter, then click the Back button in the
WinSPC Configuration Wizard once and try the database
communications test again.
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= A network protocol was enabled but the instance was not
restarted afterwards. To remedy this, repeat steps 1 and 3e-3h
of the Configure the SQL Server Browser Service and
Enable a Network Protocol section earlier in this chapter,
then click the Back button in the WinSPC Configuration
Wizard once and try the database communications test again.

16. On the Database Creation prompt, click Next. This creates the
WinSPC schema within the WinSPC database.

Win5PC Configuration Wizard

D atabase Creation

following charactenstics:

Databaze Type: Microzoft SCL Server
Databaze Mame: \WTestzerverWinSPC

Prezs Mext to continue.

==

A new, empty, WinSPC databaze will now be created an
your databaze server. vour databaze server haz the

< Back

M et =

Cancel
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17. Allow the prompt’s progress bar to complete.

Win5PC Configuration Wizard E

D atabase Creation

WINSFC A new, empty, WinSPC databaze will now be created an

FRATIFICAL FROCERS CONTROL your database server. Your database server has the
following characteristics:

Database Type: Microzoft SCIL Server
Database Mame:  A\WTestserverswinsPC

Progresz... ABOOKMREK
INNRnnn

< Back MHeut Cancel
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18. If you selected a language other than English in step 11 of this
section, an Add Language prompt appears once the WinSPC
schema is created. In this case:

a. Insert the language disk for the selected language into your
floppy drive and click the OK button. (Language disks are
included in your WinSPC materials. If you didn’t order a
language disk and, consequently, did not receive one, click the
Cancel button and complete the WinSPC Configuration
Wizard without adding the language. Later, you can order the
language disk and, once the disk arrives, add the language
using the Add Language option on the Administrator
window’s Tools menu in WinSPC. Until the language is added,
you’ll be restricted to running WinSPC in English. The
remainder of the WinSPC Configuration Wizard continues to
run in the selected language whether or not a language is added
from a language disk.)

b. Inthe message asking if you want to proceed with the addition
of the detected language, click OK.

c. If amessage indicating the detected language has already been
installed appears, click OK.

d. Allow the Adding New Language progress bar to complete.

e. When the You may now select the desired language in the
System Settings, Station Setup, or User Setup message
appears, click OK.

f. If the Add Language prompt reappears, click Cancel.
g. Remove the language disk from the floppy drive.
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THIS COMPLETES PHASE 2 OF 4.

GO TO CHAPTER 4: FIRST CLIENT
CONFIGURATION (FINAL STEPS) AND
COMPLETE PHASE 3.
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CHAPTER 2: ORACLE 10g
ASSUMPTIONS

The instructions in this chapter are based on the following
assumptions:

= Oracle Database 10g software is installed on your database server.

= An Oracle Database 10g global database of the Enterprise
Edition installation type is created and running on your database
server and you have been authorized to use part of this global
database for WinSPC.

= Oracle Database 10g Client is installed on the first WinSPC client
and that installation is of the Administrator type (as compared to
the Runtime or Custom types). (The first WinSPC client refers to
the first computer on which you want to install WinSPC. This
computer can be any computer on your network. If the operating
system of this client is Windows Vista Business, you must use the
10.2.0.3.0 edition of Oracle Database 10g Client. If the operating
system is Windows XP Pro, you may use either the 10.2.0.3.0
edition or the earlier 10.2.0.1.0 edition.)

= The necessary Oracle Database 10g Client utilities are installed an
all other clients. (If the operating system of an additional client is
Windows Vista Business, the necessary utilities are Oracle
Provider for OLE DB and Oracle Net from the 10.2.0.3.0 edition
of Oracle Database 10g Client. If the operating system is Windows
XP Pro, the necessary utilities vary with the edition of Oracle
Database 10g Client being used. If that edition is 10.2.0.3.0, the
necessary utilities are the same as those for Windows Vista
Business. If that edition is 10.2.0.1.0, the necessary utilities consist
only of Oracle Provider for OLE DB. Incidentally, regardless of
the operating system or edition of Oracle Database 10g Client
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‘A

Terminal Services

installed on your clients, if your organization’s intended use of
WIinSPC includes taking data stored in an Oracle ODBC data
source and collecting it into the Oracle database you are
configuring for WinSPC, Oracle ODBC Driver from Oracle
Database 10g Client will need to be installed on each WinSPC
client to be used in collecting that stored data. Since the presence
of this driver presents no complication, DataNet Quality Systems
recommends installing it even if the use of WinSPC to collect data
from an Oracle ODBC data source is only a possibility. The
Administrator type of client mentioned in the preceding
assumption includes this driver and consequently does not need to
separately installed on the first WinSPC client.)

The default values presented by Oracle Database 10g and Oracle
Database 10g Client during the installation process were accepted
without modification.

Any firewalls between your database server and the client stations
to be used for WinSPC are properly configured to permit database
traffic.

For implementations employing a Microsoft Terminal Services
environment, Microsoft Terminal Services is properly installed and
configured on the server designated as your Microsoft Terminal
Services server.

NOTE: You may find that users who don’t have administrative
permissions to the Microsoft Terminal Services server are
unable to launch WinSPC via a Remote Desktop Protocol
session. This is a circumstance specific to Oracle
Database 10g and Oracle Database 11g. It can be
remedied by changing the Permission Capability on the
Microsoft Terminal Services server from Full Security to
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Relaxed Security. Alternatively, consult your network
administrator and/or Oracle DBA for other remedies.

= The operating system of your database server machine is Windows
Server 2003 or Windows Server 2008.

= The operating system of the client machines to be used for
WinSPC is Windows 7, Windows Vista Business or Windows XP
Pro. (Images of client machines included in this guide are from
Vista Business.)

NOTE: If a default value was modified during the installation of
Oracle Database 10g or an operating system is different from
that stated here, adapt the instructions in this guide as needed
to accommodate the modified value or differing operating
system.

Prior to beginning this procedure, it’s advised that you locate
the hostname (or machine name) for the Oracle Database 10g
machine and the Oracle Database 10g global database system
identifier (SID), user name and password. Your database
administrator should be able to provide this information.
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Phase 1 of 4 SERVER CONFIGURATION

I
Create a Tablespace

1. On the first WIinSPC client station, launch the Enterprise
Manager Console. The default path for this is: Start > All
Programs > Oracle — OraClient10g_homel > Enterprise
Manager Console. (See the third assumption at the beginning of
this chapter for a definition of the first WinSPC client.)

NOTE: If the Enterprise Manager Console is not listed in the
Start menu, it is probably because the Administrator
installation type was not selected when Oracle Database
10g Client was installed. In this case, reinstall Oracle
Database 10g Client, selecting Administrator in the
Select Installation Type prompt and then return to this
step.

2. Inthe Add Databases To Tree prompt:

a. At Hostname, enter the machine name of the Oracle Database
10g server.

b. At Port Number, accept the default value of 1521 unless your
DBA has instructed you to use a different port number.

c. At SID, enter the system identifier for the Oracle global
database to be used by WinSPC.

d. At Net Service Name, overwrite the net service name that is
automatically created with a name you want to use to uniquely
identify the WinSPC net service. (The recommended net
service name is WINSPC.)
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e. Click OK.
" :&% Add Databases To Tree 3] ﬁ
® Add g datahasze manually
Hostname: Testserer
Fort Mumber: 16521
SI0: DRCL

et Senice Hame: [WinsSPC

" Add selected databases from your local thsnames.ora file
located in Chloraclelproductil 0.2 Mclient_1RETWORKEIADIMIM

r
=]

Cancel Help

NOTE: If the Add Databases To Tree prompt doesn’t
automatically appear after step 1, it can be displayed by
selecting Add Database To Tree from the Navigator
menu in the Oracle Enterprise Manager Console.
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3. Inthe left pane of the Oracle Enterprise Manager Console,
expand Network > Databases and click the plus sign to the left of
the net service name from step 2d.

I

ﬁ Oracle Enterprize Manager Console

File Mavigator Ohject Tools Configuration Help

.r_

Databases

B WINSPC

The databazes folder
databaszes that are ac
ou can expand a spe
administer any of the

b Instances, includin

b Schemas, including
and all other schenr
» Security, including
roles, and privileges
» Storage, including
datafiles, and rollba
b Nictrikitad inchid
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4. In the Database Connect Information prompt that is displayed:
a. At Username, enter the username for the global database.

b. At Password, enter the password associated with this user
name.

At Connect as, select SYSDBA from the dropdown list.
d. Click OK.

2 Database Connect Information

OracLe EnTERPRISE MANAGER

Usermame: |5YS

Password: |*‘*‘“‘*‘*‘*‘*

Semice:  [WINSPC

Connectas: |BYBDEA v|

)
[ Save As Lacal Preferred Credentials

(0] | Cancel) Help )I
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5. Inthe left pane, beneath the newly added net service name, expand
Storage, right-click Tablespaces and, from the shortcut menu,
select Create.

NOTE: If you do not see Create on the shortcut menu, press the
ESC button to exit the menu and right-click Tablespaces
again.

ﬁ Oracle Enterprize Manager Conscle

Eile Mavigator Ohject Tools Configuration Help

o

SR Network
e Databases

T2 WINSPC - SYS AS SYSDEA

Controlfile
Save List...
Backup Management L
t E—EDistribu Change Management... b
[2] Wareho| Find Database Qbjects. ..

=Workspace
‘ByML Database
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6. Inthe Create Tablespace prompt, on the General tab:

a. At Name, create and enter a name for the tablespace to be used
for WinSPC. (Notice that, as you enter the name, it is
automatically populated into the Datafiles section, forming a
file name for the tablespace.)
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b. At Size, double-click 5.

7 L
|_I—I7I—I7I7

WINSPC.ora CAORACLEWROD

[ Set as Default Temparar: Tablespace

. —Trr
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In the Create Datafile prompt that is displayed, click the Storage
tab.

% Create Datafile - SYS@WINSPC ()

General
Mame: CAORACLEWPRODUCTI 0.2 MORADATAORC

Tablespace: [ViiNSFC

Size:
File Size: |5 (MBytes -

[ Reuse Existing File
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8. On the Storage tab:

a. Check the Automatically extend datafile when full
(AUTOEXTEND) check box.

b. Specify 5 M Bytes as the size by which the datafile should be
incremented. (Your database administrator can monitor your
database usage and tune this value as needed.)

c. At Maximum Size, accept the default Unlimited.
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d. Click OK.
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9. Inthe Create Tablespace prompt, click Create.

WINSPC.ora CAORACLEWROD..
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10. When the Tablespace created successfully message appears,
click OK.

-

\3?; Cracle Enterprize Manager @

) Tablezpace created successiully

Create a Server Login

1. Still beneath the newly created net service name, expand Security,
right-click Users and, from the shortcut menu, click Create.
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g COracle Enterprise Manager Console

File Mavigator Ohject Tools Configuration Help _
SR Metwiork
'é‘-DDatahases
@%WINEF‘C - 55 AS SYSDEA
?Instance
Schema
o Security

Pro| Save List..
-t Storac
Cl:u

Add Privileges to User(s)...

Assign a Profile to Lser(s)...

=L Jpgt  Change Management.. »
el Rl Find Database Objects...

= JRe Find...

Bl Archive Lags
i Distributed
(2] YWarehouse
= orkspace
“YML Database

2. Inthe Create User prompt, on the General tab:

a. At Name, create and enter a name for the login. (The
recommended user name is JOHNDOE.)
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b. At Enter Password, create and enter a sufficiently strong
password for the login.

c. At Confirm Password, reenter the password.

NOTE: The name and password entered here will be used by
Oracle Database 10g to authentic WinSPC client stations
and allow authenticated stations access to the WinSPC
tablespace. This name and password combination is not
directly used by WinSPC users. WinSPC users will, later,
be assigned individual user IDs and passwords. They will
use these individual user IDs and passwords to log into
the WinSPC application on WinSPC client machines.

d. Inthe Tablespaces section, at Default, select the tablespace
name created in step 6a of this chapter’s Create a Tablespace
section.

e. At Temporary, select TEMP.
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f. Leave Status as Unlocked.
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3. Without clicking Create, click the Role tab and, in the Available
list, double-click RESOURCE. This copies RESOURCE to the
Granted list.
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E" Create User - SYS@WINSPC E

Role
Availakle:

JAVA_DEPLOY
LOGSTDEY_ADMINISTRATOR
MGMT_LISER

OEM_ADVISOR

OEM_MONITOR

OLAP_DBA

OLAP_USER

RECOVERY _CATALOG OWNMNER
RESOURCE
SCHEDULER_ADMIM

Granted:

 Role Adrnin Optior
COMMNECT x

A RESOURCE b 4
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4. Click the System tab and, in the Available list, double-click
CREATE ANY INDEX. This copies CREATE ANY INDEX to
the Granted list.
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S Create User - SYS@WINSPC E

System
Auailable:
CREATE ARY CLUSTER
CREATE ARY COMTEXT
CREATE AMY DIMEMNSIOR
CREATE AMY DIRECTORY
CREATE ARY EVALUATION COMTERT
CREATE ARY INDEX
CREATE AMY INDEXTYPE
CREATE AMY JOE
CREATE AMY LIBRARY
CREATE ARY MATERIALIZED VIEWY

v &
Qranted:
System Privilege

o |CREATE ANY INDEX

-
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5. Click Create.
6. When the User created successfully message appears, click OK.

4?; Cracle Enterprize Manager @

) User created successiully

Set the Number of Open Cursors
1. Calculate the required number of open cursors using this formula:
open_cursors = number of WinSPC licenses * 50
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2. Still in the Oracle Enterprise Manager Console, in the left pane,
expand Instance and click Configuration.

i

ﬁ Oracle Enterprize Manager Conscle

Zi:il Metwark

é—DDatabases

SELWINGPC - Y5 AS SYSDEA

ELlJSessions
FLIResaurce Consumer

F_IResaurce Flans

A Resource Plan Sche
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3. Inthe right pane, click All Initialization Parameters toward the
bottom of the General tab.

General Memaory  Fecovery REesource Monit

Ihstance State

I S

Shaowe Al States

Database and Instance Informatian

Host Mame: TESTSERVER
DB Mame: ORCL
DB Yersion: Cracle Database 109 Enterpri

YWiith the Paditioning, Spatial,
and CLAP options

Instance Mame: arel
Instance Stat Time: 26-0ct-2009 09:24:49 A

Restricted Mode: o

Archive Log Mode:  MNOARCHINWELOG

Fead Only Mode:

Started with spfile;  CIORACLEWRODUICT 0.2.0

All Initialization Parameters...

4. Inthe Edit Database: Configuration prompt, scroll to
open_cursors, replace the default number of open cursors in the
Value column with the number you calculated in step 1 and click

Apply.

Installation and Configuration Guide ‘ ‘ 63



Chapter 2: Oracle 10g

g Edit Database : Configuration - SYS@WINSPC E

All Parameters

-~ ® Rynning © SPFile

Running parameters are the parameters currently in effect far this data

Farameter Mame Yalue Default | Dynarm
hls_time_tz_format v
nls_timestamp_format v
nls_timestarmp_te_format v
ohject_cache_max_size_percent |10 L L
ohject_cache_optimal_size 102400 L L
olap_page_pool_size 1] v ¥
OpEN_CUrsors m v
open_links 4 v
open_links_per_instance 4 L
optimizer_dynamic_sampling 2 v v
optimizer_features_enahle 10.2.01 v ¥
optimizer_index_caching 0 v L
optimizer_index_cost_ad] 100 v L
optirmizer_mode ALL_ROWS L v
optimizer_secure_view_merging | TRLUE L L
os_authent_prefix OFSE ¥
0s_roles FALSE v
parallel_adaptive_multi_user TRUE v L
L Lnarallal_autnmatic tonine Fal oF o

F
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5. When the Parameters have been changed message appears, click
OK.

ﬁ?} Oracle Enterprize Manager @

) Farameters have been changed.

6. Close the Oracle Enterprise Manager Console by clicking File >
Exit.

Test the Local Net Service Name

1. Still on the first client machine, click Start > All Programs >
Oracle — OraClient10g_homel > Configuration and Migration
Tools > Net Configuration Assistant.
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2. Inthe Oracle Net Configuration Assistant: Welcome prompt,
select Local Net Service Name configuration and click Next.

Oracle Net Cenfiguration Assistant Welcome

Yielcome to the Oracle Met Configuration Assistant.
This tool will take you through the camman
configuration steps, listed below:.

Choose the canfiguration yau wauld like ta do:
" Listener configuratian

T Maming Methods configuration

® |_ocal Met Service Mame configuration

" Directory Usage Configuration

Cancel j Help ) < Back | Mext 3 )
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3. Select Test and click Next.

Oracle Net Configuration Assistant: Met Service Mame Configuration

To access an Oracle database, or other senice,
across the netwark you use a net senice name.
The Oracle Met Configuration Assistant allows you
to wiark with net service names resolved using local
naming.

Selectwhat you want to do:
T Add
T Reconfigure
T Delete

T Renamme

Cancel J Help ) < Back | Mext 3 )
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4. Select the net service name you specified in step 2d of this
chapter’s Create a Tablespace section, if it isn’t already selected,
and click Next.
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5. In the next prompt, which indicates the test did not succeed, click
the Change Login button.

Oracle MNet Configuration Assistant: Met Service Mame Configuration, Connecting  [3a)

VWait while the Cracle ket

Details:

Connecting...QRA-01017: invalid
usernamelfpassword; logan denied
The test did not succeed.

Some of the infarmation you provided may he
incorrect.

Click Back to reviews the information provided for
net service name, ar Change Login ta change

username.
Change Login

Cancel j Help )
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6. Inthe Change Login prompt, replace the default username and
password with the username and password you created in step 2 of
this chapter’s Create a Server Login section and click OK.

-

pr

Change Login
Change Login
lzername: JOHMDOE

Passwoard:

il

Qk| Cancel
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7. When the test is indicated as having succeeded, click Next.

Oracle Net Configuration Assistant: Met Service Mame Configuration, Connecting E

Wait while the Oracle Met

Details:

Connecting.. Test successiul.

Cancel J Help ) < Back R ext 25)
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8. Click Next when the net service name configuration is indicated as
complete.
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On the Welcome prompt, click Finish.

Oracle Met Configuration Assistant: Welcome

Welcame to the Oracle Met Configuration Assistant.
This toal will take you through the cammaon
configuration steps, listed below:.

Choose the configuration you would like to do:
T Ligtener configuration
" Maming Methods configuration

® | geal Met Service Name caonfiguration

" Directary Usage Canfiguration

Cancel J Help ) L Back R ext 25)

THIS COMPLETES PHASE 1 OF 4.
GO TO THE NEXT PAGE AND COMPLETE PHASE 2.

Installation and Configuration Guide ‘ ‘ 73



Chapter 2: Oracle 10g

Phase 2 of 4 FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS)

This section concerns the installation and configuration of WinSPC on
the first WinSPC client. (See the third assumption at the beginning of
this chapter for a definition of the first WinSPC client.)

( If your implementation employs Microsoft Terminal Services, see the
discussion on page 1 of this guide for direction on whether to make
‘:L your first client the Microsoft Terminal Services server or another
o computer.

Terminal Services 1 Create a folder on a network file server accessible by all client
stations that will run WinSPC. This folder’s primary purpose is to
facilitate the installation and configuration of WinSPC on all
clients other than the first client. (The recommended name for this
folder is WinSPCRemote.)

2. Share this folder and grant domain administrators at least the
minimum required permissions to it. For file servers running
Windows Server 2003, the minimum Share permissions are
Change and the minimum Security permissions are Modify. For
file servers running Windows Server 2008, the minimum Share
permissions are Contributor and the minimum Security
permissions are Modify. (For a procedure on granting Share or
Security permissions, see Appendix D: Granting Share and
Security Permissions.)

NOTE: If your WinSPC implementation is part of a workgroup
rather than a domain, grant these minimum permissions
to the local administrator who will install and configure
WinSPC on the first WinSPC client station.
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3. Log into Windows on the first WinSPC client station as a domain
administrator who also has local administrator privileges.

NOTE: |If the first WinSPC client is part of a workgroup instead
of a domain, log in as a local administrator.

4. If the operating system of the first client is Windows 7 or Vista,
disable User Account Control (UAC). Refer to Appendix H for
instructions on doing this.

5. If you downloaded Install.exe from winspc.com/downloads:

a. Transfer this file to the first WinSPC client if it was
downloaded to a different computer.

b. Double-click the file.

c. If an Open File — Security Warning prompt appears, click
Run.

d. Gotostep?7.

Installation and Configuration Guide ‘ ‘ 75


http://www.winspc.com/downloads

Chapter 2: Oracle 10g

6. If you have the WinSPC CD (whether as a result of receiving it
from DataNet Quality Systems or burning it from the WinSPC.iso
file at winspc.com/downloads) and you did not complete the
preceding step:

a. Insert and run the CD.

b. On the WinSPC Version 8.0 setup prompt that appears, click
Install or Upgrade.

WI NSPC. Version 8.0

STATISTICAL PROCESS CONTROL

FA. What's New
FA. ReadMe

v., Installation & Configuration Guide

W) Upgrade Instructions Install or Upgrade

Need Help? Dial 866.4WINSPC or 248.447.0140 www.winspc.com

c. Gotostep?7.
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7. Complete the WinSPC Installation Wizard.

NOTE: The prompts of this wizard are intended to be self-
explanatory. Consequently, they are not detailed here. If
you have a question about a prompt or want to be directed
step-by-step through the wizard, see Appendix A: The
WinSPC Installation Wizard.

8. Complete Appendix B: Installing NJWin for an Asian
Language if the first client station will need to run WinSPC in an
Asian language or you would like to run the WinSPC
Configuration Wizard in an Asian language. (The WinSPC
Configuration Wizard is the tool you will use next in this first
client configuration process.)

9. If you installed WinSPC from a CD, exit the WinSPC Version 8.0
setup prompt by clicking Close in the upper right corner and
remove the WinSPC CD from the CD-ROM drive.

10. Click Start > All Programs > WinSPC > WinSPC. This
launches the WinSPC Configuration Wizard.
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11. On the Language prompt, from the Select language list, choose a

language and click Next.

Win5PC Configuration Wizard

Language

Select lanquange:

==

IF the language selection vou prefer does not appear on
thiz goreen, contact pour zales representative for
infarmation on purchasing language installation software,

< Back

M et =

Cancel

NOTE: The language selected here is the language in which the
remainder of the WinSPC Configuration Wizard will run.
It also becomes the system-wide default language for
WIinSPC. (This default language can be changed at any

time following the completion of the WinSPC

Configuration Wizard. Once the configuration of the first
WinSPC client is complete, you can see the WinSPC
Help for more information on default languages.)
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12. On the Database Server Type prompt, select Oracle Database
10g and click Next.

WinSPC Configuration Wizard E

D atabase Server Type

WINSFC' Microzaft SOL Server 2005

T Microzoft SOL Server 2005 Express
kicrozoft SOL Server 2008
Microzoft SOL Server 2008 Express

Oracle Databaze 10q
Qracle Databaze 11g

< Back M et = Cancel
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13. On the Oracle Server Settings prompt:
a. At Path of TNSNAMES.ORA, accept the default location.

b. Inthe Database Alias text box, enter the Net Service Name
you chose in step 2d of this chapter’s Create a Tablespace
section.

c. Click Next.

WinSPC Configuration Wizard |

Oracle Server Settings

i
WINsm Enter the full path name far the lacation where paur

BPATINTICAL SSOCE R CONTR, THSMAMES. ORA file resides.

Path af THSHAMES ORA:
IE:"xn:nran::Iehprn:ndu::t'ﬂ 0.2.0czlient_1hnebwark \admin®,

Browse... |

Enter the SAL*Met aliaz of vour database.

D atabaze Alias:

WinG L
[e.0.. WinSFPC)

< Back M et = Cancel
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14. On the Database Server Log In prompt, enter the server User
Name and Password created in step 2 of this chapter’s Create a
Server Login section and click Next.

Win5PC Configuration Wizard E |

Database Server Log In

l
WINSFC Enter the uzer name and passward that pou want

FRATIFTICAL FROCERS CONTROL WiNSPC to uge when logging into your databaze server.

IJzer Mame:

JOHMDOE
[e.g.. JOHMDOE]

Pazsword:

Ixxxxxxxx

[e.g.. paszword]

< Back Meut » Cancel
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15. On the Database Communications Test prompt, click Next.

WinSPC Configuration Wizard ==

D atabase Communications Test

wllm The link. to your databaze server will now be tested. |f

FRATIFICAL FROCERS CONTROL evernthing iz zet up comectly, then this will only take a few
geconds. |f there iz a problem, then thiz could take a
couple of minutes.,

< Back

Cancel |

In the event the test fails:

= |f the error message displayed reads ORA-12154: TNS: could
not resolve the connect identifier specified., click the Back
button three times and reenter the database alias, ensuring you
have the correct name and that it is spelled correctly. Once
you’ve reentered this information, advance through the
WinSPC Configuration Wizard again by clicking Next,
verifying the information on each prompt as you do.
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= If the error message reads ORA-01017: invalid
username/password; logon denied, click the Back button
twice and reenter the server user name and password, ensuring
you have the correct user name and password and that these are
spelled correctly. Also, since passwords are case sensitive,
ensure the appropriate capitalization is used for the password.
Once you’ve reentered this information, advance through the
WinSPC Configuration Wizard again by clicking Next,
verifying the information on each prompt as you do.

16. On the Database Creation prompt, click Next. This creates the
WinSPC schema within the WinSPC database.

Win5PC Configuration Wizard =™

D atabase Creation

A new, empty, WinSPC databaze will now be created an
your database server. Your database server has the
following characteristics:

Database Type: Oracle Database 10g
Database Mame: "WinSPC

Press Hext to continue.

< Back Meut » Cancel
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17. Allow the prompt’s progress bar to complete.

Win5PC Configuration Wizard E

D atabase Creation

WINSFC A new, empty, WinSPC databaze will now be created an

FTATIFTICAL FROCERS CONTIROL your database server. Your database server has the
following characteristics:

Database Type: Oracle Database 10g
Database Mame: "WinSPC

Progresz... EVLOG
Hnnl

< Back MHeut Cancel
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18. If you selected a language other than English in step 11 of this
section, an Add Language prompt appears once the WinSPC
schema is created. In this case:

a. Insert the language disk for the selected language into your
floppy drive and click the OK button. (Language disks are
included in your WinSPC materials. If you didn’t order a
language disk and, consequently, did not receive one, click the
Cancel button and complete the WinSPC Configuration
Wizard without adding the language. Later, you can order the
language disk and, once the disk arrives, add the language
using the Add Language option on the Administrator
window’s Tools menu in WinSPC. Until the language is added,
you’ll be restricted to running WinSPC in English. The
remainder of the WinSPC Configuration Wizard continues to
run in the selected language whether or not a language is added
from a language disk.)

b. Inthe message asking if you want to proceed with the addition
of the detected language, click OK.

c. If amessage indicating the detected language has already been
installed appears, click OK.

d. Allow the Adding New Language progress bar to complete.

e. When the You may now select the desired language in the
System Settings, Station Setup, or User Setup message
appears, click OK.

f. If the Add Language prompt reappears, click Cancel.
g. Remove the language disk from the floppy drive.
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THIS COMPLETES PHASE 2 OF 4.

GO TO CHAPTER 4: FIRST CLIENT
CONFIGURATION (FINAL STEPS) AND
COMPLETE PHASE 3.
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ASSUMPTIONS

The instructions in this chapter are based on the following
assumptions:

= Oracle Database 119 software is installed on your database server
and the installation type is Enterprise Edition.

= Oracle Database 11g’s Starter database is created and running on
your database server and you have been authorized to use this
database for WinSPC.

= The Net Configuration Assistant from Oracle Database 119
Client is installed on the first WinSPC client machine. (The first
WIinSPC client machine simply refers to the first computer on
which you want to install WinSPC. This computer can be any
client machine on your network.)

= Oracle Provider for OLE DB from Oracle Database 11g Client is
installed on all client machines which are to run WinSPC
(including the first client). (Incidentally, if your organization’s
intended use of WinSPC includes taking data stored in an Oracle
ODBC data source and collecting it into the Oracle database you
are configuring, Oracle ODBC Driver from Oracle Database 11g
Client will need to be installed on each WinSPC client to be used
in collecting that stored data. Since the presence of this driver
presents no complication, DataNet Quality Systems recommends
installing it even if the use of WinSPC to collect data from an
Oracle ODBC data source is only a possibility.)

= The default values presented by Oracle Database 11g during the
installation process were accepted without modification.
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‘A

Terminal Services

Any firewalls between your database server and the client
machines to be used for WinSPC are properly configured to permit
database traffic.

For implementations employing a Microsoft Terminal Services
environment, Microsoft Terminal Services is properly installed and
configured on the server designated as your Microsoft Terminal
Services server.

NOTE: You may find that users who don’t have administrative
permissions to the Microsoft Terminal Services server are
unable to launch WinSPC via a Remote Desktop Protocol
session. This is a circumstance specific to Oracle
Database 10g and Oracle Database 11g. It can be
remedied by changing the Permission Capability on the
Microsoft Terminal Services server from Full Security to
Relaxed Security. Alternatively, consult your network
administrator and/or Oracle DBA for other remedies.

If the edition of Oracle Database 11g to be configured for use
with WIinSPC is Release 2, the Server Class option was selected
during the installation. This option is presented on the on the
System Class installation prompt but is not selected by default.

The operating system of your database server machine is Windows
Server 2003 or Windows Server 2008.

The operating system of the client machines to be used for
WinSPC is Windows 7, Windows Vista Business or Windows XP
Pro. (Images of client machines included in this guide are from
Vista Business.)
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NOTE: If a default value was modified during the installation of
Oracle Database 119 or an operating system is different from
that stated here, adapt the instructions in this guide as needed
to accommodate the modified value or differing operating
system. Prior to beginning this procedure, it’s advised that
you locate the hostname (or machine name) for the Oracle
Database 11g machine and the global database name and
SYS account password assigned during the installation of
Oracle Database 11g. Your database administrator should be
able to provide this information.
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Phase 1 of 4 SERVER CONFIGURATION
[
Create a Tablespace

1. On the database server machine, launch Database Control for the
database to be used by WinSPC. The default path for this is Start
> All Programs > Oracle — OraDB11g_homel > Database
Control - orcl.

2. Onthe Oracle Enterprise Manager 11g login page that is
displayed:

a. At User Name, enter SYS.

b. At Password, enter the password for the SYS user name.
c. At Connect As, select SYSDBA.

d. Click Login.

ORACLE Enterprise Manager 11¢

Datahase Control

*User Name |SYS
*Password  eesessse
Connect As  |ENES{BEE v
Login )
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3. On the Oracle Enterprise Manager 11g page that appears, click
Server.

ORACLE Enterprise Manager 11g ence
Database Control m

Logged in As SYS

Database Instance: orcl

Latest Data Collected From Target Jul 28, 2009 5:50:24 AMPDT (_Reffesh ) view Data Automatically (60 sec) ¥
General Active Sessions SQL Response Time

Shutdown ) (_Black Out

28 20
Stats 21 15 —
Up Since Jul 28, 2009 5:41:33 AM PDT 4 Wit 30 e
Instance Name orcl = Refe
Versin 111060 07 L 05 Lp
10 Tasmaes it
Listener 2 L)
Load 500 Paging 7.05 Mairm CPU 1 SQL Response Time (%) 112155
Edit Reference Collection
Diagnostic Summary Space Summary High Availability
ADOMFidngs N ACOM run availsble Database Size (GB) 2zl Instarce Recovery Time (sec)
AlertLog Ré- g Problem Tablespaces Lasteachp  n/a
active Inciderts @) Segment Advisor Recommendations Usable Flash Recavery area (%)
Policy Violations v Flashback Database Logging

Oump AreaUsed (%) Unavailable

4. On the Server page, under Storage, click Tablespaces.

ORACLE Enterprise Manager 11g Y
Database

Logged n As Y5

Database Instance: orcl
5 s = =

Storage Database Configuration Oracle Scheduler

Statistics Management Resource Manager Security

Query Optimizer Change Database
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5. On the Tablespaces page, click Create.

rprise Manager 11g

Datat

Tablespaces

Object Type| Tablespace L
Search
Enter an cbject name 1o fier the data that & displayed in your resuls set.

bl (_Create )

By defau, the search returns ol uppercase matches beginning with the string you entered. To run an exact o case-senskive match, double quote the search string. You

an use the wdcard symbel (%) i1 &
Selection Mode | Single ¥ (Create )
(_Edit ) View ) Delete ) actions Add Datafile ¥| 6o
Select Name ~_| Allacated Size (W) used(va)|Allocated Used(% Allocated Free Spacef tatus| Datafiles|r xtent t t t
© pw 1000 77.4 I 774 26 v 1 PERMANENT LOCAL AUTO
(o) 6050 577.5 I 5.5 75 v 1 PERMANENT LOCAL AUTO
o 6300 662,+ G .0 76 v 1 PERMANENT LOCAL MaNUAL
o 200 o0 I 00 200 v 1 TEMPORARY LOCAL MaNUAL
o 140.0 102.0 I 735 71 v 1UNDO LOCAL MANUAL
(o] 50 3.1 I 25 19 v 1 PERMANENT LOCAL AuTO
Total Allocated See (M) 1,560.0 vonine  XOffine & Read Only

Total Used (MB) 1,443.3
Total Allocated Free Space (MB) 116.7

Database | Setp | Breferences | bl | Logowt

6. On the Create Tablespace page, at Name, enter a name for the
tablespace to be used by WinSPC and then, in the bottom right
corner, click Add.

ORACLE Enterprise Manager 11g
Database Control

y osoieee B

Logged in As SYS

Datat

ance: ord > Tablespaces

Create Tablespace

(ShowsoL) ((Caneel) (0K)

General
« Name |WircPd|
Extent Managen. Status
Ouocalytnaged - Name [WinsPd] |
O Dictionary Managed
Ooffine
[JEncryption (Encryption Options
© Temporary
[set as default temporary tablespace
Oundo
Add
Undo Retention Guarantee O'Yes ®No
Datafiles

[Cuse bigfile tablespace
Tabisspace can have orly cne datafis wkh no practical sae .

2
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7. On the Add Datafile page:

a.

At File Name, enter a name for the datafile to be used by
WinSPC.

At File Size, enter 5 MB.

At Storage, check the Automatically extend datafile when
full (AUTOEXTEND) check box and specify an Increment

amount of 5 MB.
d. Click Continue.

ORACLE Enterprise Manager 11g

Database

atabase Instance: orcl

dd Datafile

« File Name [WinsPC
» Fila Directory |C:\APPVADMINISTRATOR\ORADATA\CRCLY
Tablespace WINSPC
File See S M8 v
[JReuse Existrg File
Storage
[ automatically extend datafile when full (AUTOEXTEND)
Increment |5 e v
Maximum File Sz ® Unlimited
Ovakse M8 ¥

@11P changes mads cn this pags

Copyright © 199, 2007, Orale. Allrights reserved,
r.zh, 30 Edwards, Peoplesoft, and Retek are registered trademarks of Oradle Corpora:

Cancel ) (_Continue

4 -
Continue

* File Name \WinSPC
* File Directory |C:\APP\ADMINISTRATOR\ORADATA\ORCLY
Tablespace WINSPC
File Size [5 [ve v
[CJReuse Existing File
Storage
[¥] Automatically extend datafile when full (AUTOEXTEND)

Cancel ) ( Continue

Increment |5 [me v
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8. On the Create Tablespace page, note the Information message
that is displayed and click OK.

ORACLE Enterprise Manager 11g
Datab ol

we: orcl > Tablespaces Logged in As SYS
Create Tablespace

Databa

Show SGL ) (_Cancel ) (0K

D Information
Modification to the datafie will ot take effect unti you clik "OK” button.

General

e (OK)

Extent Managem. @ Information
©Locally Managed Modification to the datafile will not take effect until you click "OK" button.

O Dictionary Managed

Ooffine
[CEncryption (_Encryption Options

O Temporary
[ISet as default temporary tablespace
Oundo

Undo Retention Guarantee O Yes @No

9. Onthe Tablespaces page, note the Confirmation message that
appears and, directly above it, click Database Instance.

ORA
Datab

Datab ce: orcl ogged
(D Confirmation
The object has been created successfully

Tablesp
Object Type| Tablespace v

Search Database Instance: orcl >

Enter an ot

eriten () Confirmation
By defad The d)pct has been created su:cmﬁ]"y o the sarch atring, You ¢an uss the widcard symbol (%) in a doubls quoted strng.

Selection Mode Croate
([Edit ) View ) Delete ) actions | Add Datafile vl o)
Select Name | Aliocated Size(MB)| Space Used(MB)|Allocated Space Used(%) Aliocated free Space(M8)|status|Datafiles|rype |extent Management |Segment Management
® PLE 1000 77.4 I 774 26 v 1 PERMANENT LOCAL AuTO
(0] 606.4 577.6 I 5.2 288 v 1 FERMANENT LOCAL AuTO
o TEM 650.0 662.4 I— cc .5 76 v 1 PERMANENT LOCAL MANUAL
[0) 200 oo I 00 200 v 1 TEMPORARY LOCAL MANUAL
(o) 160.0 e 41 v 1UNDO LOCAL MANUAL
o S0 3. I 525 19 v 1 PERMANENT LOCAL AUTO
o 50 o I 12 49 v 1 PERMANENT LOCAL AUTO
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Create a Server Login
1. Back on the Server page, under Security, click Users.

ORACLE Enterprise Manager 11g

Database Control m

Logoed in As SYS
Database Instance: orcl
Storage Database Configuration Oracle Scheduler
N Manags
Mar ,
Statistics Management Security

Query Optimizer Change Database

2. On the Users page, click Create.

ORACLE Enterprise Manager 11g

Database Control m

Database Instance; ord

Users
Search
Enter 3n cbject name to filter the data that is displayed in your results set.
Object Name
o)
By default, the search returns &l uppercase matches begnning with the string you entered. To run an exact or case-sensitive match, double quote the search str
Selection Mode |Sngle ¥ (Oma)
(_Edit) View ) Delete ) actions Create Like ¥l 6o) 1-250f38 W[ Next13 &
Select UserName - |Account Status __fexpiration Date [pefavit Tablespace _|remporary Tablespace _|profiie
@  anonw EXPIRED 8 LOCKED 2l 21, 2009 7:50:33 AM POT B DEFALLT Oct 15, 2007 10:36:34 AM FOT
(o] EXPIRED 8 LOCKED  ul 21, 2009 7:50:33 AM POT SERS DEFAULT Oct 1S, 2007 11:06:44 AM FOT
o EXPIRED 8 LOCKED 2l 21, 2009 7:50:33 4M POT ER DEFALLT Jul 21, 2000 7:45:58 AM POT
[¢] TXS EXPIRED 8 LOCKED  1ul 21, 2009 7:50:33 AM PDT L TEME DEFALT Oct 1S, 2007 10:35:40 AM FOT
(o) 1L oFEN Jan 17, 2010 7:51:49 AM PST YSAL 10 MONITORING_FROFILE  Oct 15, 2007 10:23:30 AM FOT
o EXPIRED 8 LOCKED SEF E DEFALT Oct 15, 2007 10:11:17 AM FOT
O sy EXPIRED 8 LOCKED Ml 21, 2009 7:50:33 AMPOT  Sisaix EL DEFALT Oct 15, 2007 10:35:14 AM FOT
[0) : EXPIRED 8 LOCKED 2l 21, 2009 7:50:33 AM POT DEFALLT Oct 15, 2007 11:06:45 AM POT
O Flows L EXPIRED 8 LOCKED 2l 21, 2009 7:50:33 AM POT B DEFALLT Oct 15, 2007 11:06:44 AM POT
O & EXPIRED 8 LOCKED 2l 21, 2009 7:50:33 4M POT i DEFALT Jul 21, 2009 7:45:58 AM POT
o EXPIRED B LOCKED )il 21, 2009 7:50:33 AMPDT  LSERS EMY DEFALLT 2ul 21, 2009 7:45:58 AM POT

Installation and Configuration Guide



Chapter 3: Oracle 119

3. On the Create User page:

a. At Name, create and enter a name for the login. (The
recommended user name is JOHNDOE.)

b. At Enter Password, create and enter a sufficiently strong
password for the login.

c. At Confirm Password, reenter the password.

NOTE: The name and password entered here will be used by
Oracle Database 119 to authentic WinSPC client
machines and allow authenticated machines access to the
WIinSPC tablespace. This name and password
combination is not directly used by WinSPC users.
WIinSPC users will, later, be assigned individual user IDs
and passwords. They will use these individual user 1Ds
and passwords to log into the WinSPC application on
WIinSPC client machines.

d. At Default Tablespace, enter the tablespace name specified in
step 6 of this chapter’s Create a Tablespace section.

e. At Temporary Tablespace, enter TEMP.
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f.  Without clicking OK, click the Roles tab.

ORACLE Enterprise Manager 11g
Datal of

(ShowsoL) (Cancel) (0K)

*Name | JOHNDOE
Profile  DEFALLT -~
Authentication | Password ¥
«Enter Password essessse
* Confirm Password sessssss

For Password choice, th role is authorized via passward,

Dlexpre Passward now «Name |JOHNDOE
Default Tablespace WINSPC &
Temporary Tablespace ‘TEMP e Profile | DEFAULT v

Status OlLocked @ Unlocked Authentication |Password v |

*Enter Password eessesee

R- 0 le‘:: patar * Confirm Password eeesssse
e B Pae sl e o f vl Copirdin sl For Password choice, the role is authorized via password.
— [Dexpire Password now
Default Tablespace \WINSPC (
Temporary Tablespace [ TEMP | (

Status O Locked ® Unlocked

On the Roles tab, click Edit List.

Show 86L ) (_Cancel ) (0K

Roles

Eail List
Rale | Admin Option 1 Default f

R | " (_Edit List )=~

Roles
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5. On the Modify Roles page, from the Available Roles list, select
RESOURCE and click Move.

ORACLE Enterprise Manager 11g

Database Instance: orcl
Modify Roles

Avallable Roles Selected Roles

OWB_USER - > [conmecT
RECOVERY_CATALOG_OWNER |

SCH
SELEC
SPATL
SPATIAL
WFS_Us:

WKUSER
WM_ADMIN_ROLE v

This moves RESOURCE to the Selected Roles list.
6. Click OK.
7. Back on the Create User page, click System Privileges.

ORACLE Enterprise Manager 11g s M Y
Create User
Roles
Role . Admin Option | Default =
s System Privileges | g 2
Roles %
s )
Database | g | e I D | Lo
8. On the System Privileges tab, click Edit List.
ORACLE Enterprise Manager g
Create User
Show SOL ) (_Cancel ) (0K )
System Privileges
System Privilege P — Edit List
No items found
System Privileges.
| EditList Jowo
Database | 4 I o | Log
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9. On the Modify System Privileges page, from the Available
System Privileges list, select CREATE ANY INDEX and click
Move.

ancel ) (OK)

Selected System Privileges

Cancel ) (0K
Database | 1 1 |

This moves CREATE ANY INDEX to the Selected System
Privileges list.

10. Click OK.
11. Back on the Create User page, click OK again.

nterprise Manager 11g Setup Preferences Helo Logout

((8how SGL ) (_Cancel ) (0K )
Gereral  Roles | System Privileges | Object Frivieqe

Edit List )
‘System Privilege | Admin Option
CREATE ANY INDEX 8] \

ncel ) ((OK)
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12. On the Users page, note the Confirmation message that appears
and, directly above it, click Database Instance.

ORACLE Enterprise Manager 119

tion
The object has been created successfully
Users
S Oboct TypelUser 2

Search B

o R Database Instance: orcl >

Object Name . .

= (D Confirmation
The object has been created successfully
Selection Mode |Single ¥ (Create )
Ednt ) View ) Delete ) actione Create LRE. T 1-250f39 &
Soloct UserName |account status |expiration Date |pefault |temporary Tables |profie |created |
® EXPIRED 8 LOCKED 2ul 21, 2009 7:50:33 AM POT E DEFALLT Oct 1S, 2007 10:36:34 AM PDT

EXPIRED & LOCKED  ul 21, 2009 7:50:33 AM FOT DEFALT Oct 15, 2007 11:06:44 AM PDT
EXPIRED 8 LOCKED 2ul 21, 2009 7:50:33 AM POT DEFALT Jul 21, 2009 7:45:58 AM POT
EXPIRED 8.LOCKED 321, 2009 7:50:33 AM POT ceraT Cxct 15, 2007 10:35:40 AMPOT
OPEN Jan 17, 2010 7:51:49 AM PST MONITORING_PROFILE Oct 15, 2007 10:23:30 AM POT
EXPIRED 8 LOCKED DEFALT Oct 15, 2007 10:11:17 AM POT
EXPIRED 8 LOCKED 2ul 21, 2009 7:50:33 AM FOT DEFALLT Oct 15, 2007 10:35:14 AM PDT
EXPIRED & LOCKED 2l 21, 2009 7:50:33 AM FOT DEFALT Oct 15, 2007 11:06:45 AM PDT
EXPIRED 8 LOCKED ul 21, 2009 7:50:33 AM POT = DEFALLT Oct 15, 2007 11:06:44 AM PDT

Set the Number of Open Cursors
1. Calculate the required number of open cursors using this formula:
open_cursors = number of WinSPC licenses * 50

2. On the Server page again, under Database Configuration, click
Initialization Parameters.

ORACLE Enterprise Manager 11g
Jatabase Control

Database Instance: orcl

Server
Storage Database Configuration Oracle Scheduler
T I ey AR
Initialization Parameters
Statistics Management Resource Manager

Query Optimizer Change Database
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This causes the Initialization Parameters page to appear.

ORACLE Enterprise Manager 11g ks 18
— y.onnses MR

Logged i As S5
(showsol) (Reven) (Apply)

Datab,

Initialization Parameters
current
The parameter vakues listed here are currently used by the rumning nstance(s). You can chang static parameters in SPFile mode,
Name Basic_Modified Dynamic Category
Al [an ] [an ] [an ¥i6s)
Fiter on 3 name cr partil name
[lapply changes n current running instance(s) mode o SPFile. For Static parameters, you must restart the database,
Save o File ) (_Show All
1500288 ¥ 2

N Eicik | J liype _|sasicjvodified|oynamic|category

= Security and
audit_file_dest o C:\APP\ADMINIS TRATOR\ADH String o v madm:;
audt_trail fo) o8 Swing v Security and
Auditing
diagrioste_dest C\APPVADMINISTRATOR sting v v Mecallanecus
dispatchers jo) (PROTOCOL=TCP) (SERVICE= Sting v v Shared Server
compatible fo] 111000 stng v v Miscellanecus
control_files o) C-\APP\ADMINISTRATOR\ORADATA\ORCL\CONTROLO2.CTL', g | » | v File
C:\APPAADMINIS TRATOR\ORADATA\ORCL\CONTROLO3.CTL, Configuration
CAPPAADMINISTRATOR\ORADATA\ORCL\CONTROLOL.CTL!
do_block_sze jol 8192 Integer v v Memory
b_domain o) swng L, o Databass
Identification

On this page, scroll down until, in the Name column, you see
open_cursors and, in this row’s Value column, enter the number
you calculated in step 1 of this section.

M Bg
memory_targst Integer | Y ¥ ey
= 00 ® Cursors and
o sl 15| LA ¥ Lbrary Cache
processes = eger L, o Processes and
s
remote_logn_passwi Svng o v Security and
Auditng
tic Undo

undo_tablespace

b bpen_cursors o 300 } et

db_creato_file_dest

B
)
g
3
<
<

Configuration
2 B File
db_create_onine_log_dest_1 o g | v ¥ Configuration
db_create_online_log_dest 2 5 St B Flle
_create_onkine_log_dest Jo) i ¥ Configration
istance_nurmber o) 0 Intager Chuster
Database
Iog_archive_dest_1 Jol Sting | v v Archiving
fog_archive_dest 2 jo] srg | v v Archwing
log_archive_dest_state_1 jo) enable ¥ srrg | v v Archiing
log_archive_dest_state_2 o enable 2% Sting v v Archiving
nks_tanguage Jo) AMERICAN srg | v NS
nis_territory fo) AMERICA sthg | v NS
e o 8g Hash Jors,
PO Aogrege. taroet o Intwger ¥ ¥ Btmap Indexes
= Netwerk
remote_listener Jo) gl ¥ Regetration
rolback_segments Jo) svng | o Automatic Undo
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4. Scroll back up to the top of the page and click Apply, noting the
Update Message that appears as a result.

ORACLE Enterprise Manager 11g
abase Control

0gged In As S
ShowSOL ) (Revert) (_Apply

(D Update Message
The changes have been made successfull. It may take a while bafore the changes take effect.

Initialization

\
current . Apply
The parameter values I

Name (D Update Message
- The changes have been made successfully. It may take a while before the changes take effect.

Dl apply changes in current

SavetoFiie ) (ShowAil)
1-50 of 288 ~
Name [Help|revisions|value |comments liype _|Basicjviodifiedjoynamic|category
E Security and
audit_file_dest o C:\APP\ADMINISTRATOR\ADN Strng v ) Mlm“;
audt_trail o ) strng v Security and
Auditing
diagrostic_dest C:\APPVADMINISTRATOR String v v Miscellanecus
dispatchers o (PROTOCOL=TCF) (SERVICE= String v v Shared Server
compatble o 111000 Strg v v Miscellanecus
control_files o) C:\APP\ADMINISTRATOR\ORADATAYORCL\CONTROLO2.CTL, svng | o | » File
C:\APP\ADMINISTRATOR\ORADATAVORCL\CONTROLO3.CTL', Configuration

'C:\APPAADMINISTRATOR\ORADATA\ORCL\CONTROLO1.CTL!

5. Click Logout in the top right corner of the Oracle Enterprise
Manager 11g page.

6. Close your browser.

Add the Local Net Service Name

1. On the first client machine, launch Net Configuration Assistant,
the default path for which is Start > All Programs > Oracle —
OraClientllg_homel > Configuration and Migration Tools >
Net Configuration Assistant.
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In the Oracle Net Configuration Assistant prompt, on the

Welcome prompt, select Local Net Service Name configuration
and click Next.

Oracle Net Configuration Assistant: Welcome

VWelcome to the Oracle Met Configuration Assistant.
This tool will take you through the common
configuration steps, listed helow.

Choaose the configuration you wauld like to da:
T Listener configuration

T Maming Methods configuration

® | ncal Net Service Name configuration

" Directary Usage Configuration

Cancel ) Help ) L Back ] Mext 2 |
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3. On the Net Service Name Configuration prompt, accept the Add
default and click Next.
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4. On the Net Service Name Configuration, Service Name prompt,
at Service Name, enter the fully qualified service name for the
Oracle database and click Next. (The fully qualified service name
consists of two names separated by a period: the service name
assigned during the setup of Oracle 11g Database, which by
default is the same as the global database name; and the name
assigned to the domain of which the database server is a member.)

Oracle Net Configuration Assistant: Net Service Name Configuration, Service Name

Each Oracle database or service has a service name. An Oracle
datahase's service name is normally its global database name.
Enter the service name of the datahase or other service you want
to access.

Service Name: ORCLMYDOMAIN.COM

Cancel ) Help ) < Back | Next 39)
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5. On the Net Service Name Configuration, Select Protocols
prompt, select TCP and click Next.

Oracle Net Configuration Assistant: Net Service Name Cenfiguration, Select Protoceols

To communicate with the database across a netwoark, a network
protocol is used. Selectthe protocol used for the database you
wantio access.

TCPS
IPC
WP

;

Cancel ) Help ) & Back
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On the Net Service Name Configuration, TCP/IP Protocol
prompt, at Host Name, enter the name of the database server
machine and click Next.

Oracle Net Configuration Assistant: Net Service Mame Configuration, TCP/IP Protocol (=3

To communicate with the database using the TCPAP protacal, the
database computer's hast name is required. Enter the host name
for the computer where the database is located.

Hast name: TESTSERVER

ATCPIP port number is also required. In most cases the
standard port number should be used.

® | e the standard port number of 1521

T Usge another port nurmber: [1 521

Cancel ) Help ) & Back ] Mext 2 |
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7. On the Net Service Name Configuration, Test prompt, select
Yes, perform a test and click Next.
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On the Net Service Name Configuration, Connecting prompt,
which indicates the test did not succeed, click the Change Login
button.

Oracle Net Configuration Assistant: Net Service Name Configuration, Cennecting e

Wyait while the Oracle Met Configuration Assistant tries to
connectto the database using the infarmation you
provided. .

Details:

Connecting.. ORA-01 017 invalid usernamelpassword; logon
denied
The test did not succeed.

Some ofthe information you provided may be incorrect.

Click Back to review the information provided for net service
name, ar Change Login to change username.

Change Login

Cancel ) Help )
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9. Inthe Change Login prompt, replace the default username and
password with the username and password you created in step 3 of
this chapter’s Create a Server Login section and click OK.

-

pr

Change Login
Change Login
lzername: JOHMDOE

Passwoard: ki

T

2

Qk| Cancel
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10. On the Net Service Name Configuration, Connecting prompt,
when the test is indicated as having succeeded, click Next.

Oracle Net Configuration Assistant: MNet Service Mame Cenfiguration, Connecting [ |

Wait while the Oracle Met Configuration Assistant tries to
connectto the database using the information you
provided...

Details:

Connecting.. Test successful.

Cancel ) Help ) < Back Mext »)
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11. On the Net Service Name Configuration, Net Service Name
prompt, at Net Service Name, rename the default net service name

and click Next. (The suggested name is WinSPC.)

Oracle Net Configuration Assistant: Net Service Name Configuration, Met Service Mame (=3

Enter a name far this net serice name.

The QOracle Met Configuration Assistant has
defaulted the net semvice name to be the same as
the service name you entered earlier,

Met Service Mame: WinsSPC

Cancel ) Help ) & Back ] Mext 2 |
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12. On the Net Service Name Configuration, Another Net Service
Name prompt, accept the No default and click Next.
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13. On the Net Service Name Configuration Done prompt, click
Next.
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14. On the Welcome prompt again, click Finish.

Oracle Net Configuration Assistant: Welcome

VWelcome to the Oracle Met Configuration Assistant.
This tool will take you through the common
configuration steps, listed helow.

Choaose the configuration you wauld like to da:
T Listener configuration

T Maming Methods configuration

® | ncal Net Service Name configuration

" Directary Usage Configuration

Cancel ) Help ) L Back

THIS COMPLETES PHASE 1 OF 4.
GO TO THE NEXT PAGE AND COMPLETE PHASE 2.
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Phase 2 of 4 FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS)
BN | This section concerns the installation and configuration of WinSPC on

Terminal Services

the first WIinSPC client. (See the third assumption at the beginning of
this chapter for a definition of the first WinSPC client.)

If your implementation employs Microsoft Terminal Services, see the
discussion on page 1 of this guide for direction on whether to make
your first client the Microsoft Terminal Services server or another
compulter.

1. Create a folder on a network file server accessible by all client

stations that will run WinSPC. This folder’s primary purpose is to
facilitate the installation and configuration of WinSPC on all
clients other than the first client. (The recommended name for this
folder is WinSPCRemote.)

Share this folder and grant domain administrators at least the
minimum required permissions to it. For file servers running
Windows Server 2003, the minimum Share permissions are
Change and the minimum Security permissions are Modify. For
file servers running Windows Server 2008, the minimum Share
permissions are Contributor and the minimum Security
permissions are Modify. (For a procedure on granting Share or
Security permissions, see Appendix D: Granting Share and
Security Permissions.)

NOTE: If your WinSPC implementation is part of a workgroup
rather than a domain, grant these minimum permissions
to the local administrator who will install and configure
WinSPC on the first WinSPC client machine.
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3. Log into Windows on the first WinSPC client machine as a domain
administrator who also has local administrator privileges.

NOTE: If the first WinSPC client machine is part of a workgroup
instead of a domain, log in as a local administrator.

4. If the operating system of the first client is Windows 7 or Vista,
disable User Account Control (UAC). Refer to Appendix H for
instructions on doing this.

5. If you downloaded Install.exe from winspc.com/downloads:

a. Transfer this file to the first WinSPC client if it was
downloaded to a different computer.

b. Double-click the file.

c. If an Open File — Security Warning prompt appears, click
Run.

d. Gotostep?7.
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6. If you have the WinSPC CD (whether as a result of receiving it
from DataNet Quality Systems or burning it from the WinSPC.iso
file at winspc.com/downloads) and you did not complete the
preceding step:

a. Insert and run the CD.

b. On the WinSPC Version 8.0 setup prompt that appears, click
Install or Upgrade.

WI NSPC. Version 8.0

STATISTICAL PROCESS CONTROL

FA. What's New
FA. ReadMe

v., Installation & Configuration Guide

W) Upgrade Instructions Install or Upgrade

Need Help? Dial 866.4WINSPC or 248.447.0140 www.winspc.com

c. Gotostep?7.
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7.

10.

Complete the WinSPC Installation Wizard.

NOTE: The prompts of this wizard are intended to be self-
explanatory. Consequently, they are not detailed here. If
you have a question about a prompt or want to be directed
step-by-step through the wizard, see Appendix A: The
WinSPC Installation Wizard.

Complete Appendix B: Installing NJWin for an Asian
Language if the first client machine will need to run WinSPC in
an Asian language or you would like to run the WinSPC
Configuration Wizard in an Asian language. (The WinSPC
Configuration Wizard is the tool you will use next in this first
client configuration process.)

If you installed WinSPC from a CD, exit the WinSPC Version 8.0
setup prompt by clicking Close in the upper right corner and
remove the WinSPC CD from the CD-ROM drive.

Click Start > All Programs > WinSPC > WiInSPC. This
launches the WinSPC Configuration Wizard.
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11. On the Language prompt, from the Select language list, choose a

language and click Next.

Win5PC Configuration Wizard

Language

Select lanquange:

==

IF the language selection vou prefer does not appear on
thiz goreen, contact pour zales representative for
infarmation on purchasing language installation software,

< Back

M et =

Cancel

NOTE: The language selected here is the language in which the
remainder of the WinSPC Configuration Wizard will run.
It also becomes the system-wide default language for
WIinSPC. (This default language can be changed at any

time following the completion of the WinSPC

Configuration Wizard. Once the configuration of the first
WinSPC client is complete, you can see the WinSPC
Help for more information on default languages.)
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12. On the Database Server Type prompt, select Oracle Database
11g and click Next.

WinSPC Configuration Wizard E

D atabase Server Type

WINSFC' Microzaft SOL Server 2005

T Microzoft SOL Server 2005 Express
Microsoft SQL Server 2003
Microsoft SOL Server 2008 Express
Qracle Databaze 109

Qracle Databaze 11g

< Back M et = Cancel
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13. On the Oracle Server Settings prompt:
a. At Path of TNSNAMES.ORA, accept the default location.

b. Inthe Database Alias text box, enter the Net Service Name
you chose in step 11 of this chapter’s Add the Local Net
Service Name section.

c. Click Next.

WinSPC Configuration Wizard |

Oracle Server Settings

i
WINsm Enter the full path name far the lacation where paur

BPATINTICAL SSOCE R CONTR, THSMAMES. ORA file resides.

Path af THSHAMES ORA:
IE:'&app"-.D amainddrinhproducty 17,7, Thelisnt_1 snebwaork

Browse... |

Enter the SAL*Met aliaz of vour database.

D atabaze Alias:

WinSPC
[e.0.. WinSFPC)

< Back M et = Cancel
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14. On the Database Server Log In prompt, enter the tablespace login
User Name and Password created in step 3 of this chapter’s
Create a Server Login section and click Next.

Win5PC Configuration Wizard E |

Database Server Log In

l
WINSFC Enter the uzer name and passward that pou want

FRATIFTICAL FROCERS CONTROL WiNSPC to uge when logging into your databaze server.

IJzer Mame:

JOHMDOE
[e.g.. JOHMDOE]

Pazsword:

Ixxxxxxxx

[e.g.. paszword]

< Back Meut » Cancel
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15. On the Database Communications Test prompt, click Next.

WinSPC Configuration Wizard ==

D atabase Communications Test

wllm The link. to your databaze server will now be tested. |f

FRATIFICAL FROCERS CONTROL evernthing iz zet up comectly, then this will only take a few
geconds. |f there iz a problem, then thiz could take a
couple of minutes.,

< Back

Cancel |

In the event the test fails:

= |f the error message displayed reads ORA-12154: TNS:could
not resolve the connect identifier specified, click the Back
button three times and reenter the database alias, ensuring you
have the correct name and that it is spelled correctly. Once
you’ve reentered this information, advance through the
WinSPC Configuration Wizard again by clicking Next,
verifying the information on each prompt as you do.
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= If the error message reads ORA-01017: invalid
username/password; logon denied, click the Back button
twice and reenter the server user name and password, ensuring
you have the correct user name and password and that these are
spelled correctly. Also, since passwords are case sensitive,
ensure the appropriate capitalization is used for the password.
Once you’ve reentered this information, advance through the
WinSPC Configuration Wizard again by clicking Next,
verifying the information on each prompt as you do.

16. On the Database Creation prompt, click Next. This creates the
WinSPC schema within the WinSPC database.

Win5PC Configuration Wizard =™

D atabase Creation

A new, empty, WinSPC databaze will now be created an
your database server. Your database server has the
following characteristics:

Database Type: Oracle Databasze 11g
Database Mame: "WinSPC

Press Hext to continue.

< Back Meut » Cancel
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17. Allow the prompt’s progress bar to complete.

Win5PC Configuration Wizard E

D atabase Creation

WINSFC A new, empty, WinSPC databaze will now be created an

FTATIFTICAL FROCERS CONTIROL your database server. Your database server has the
following characteristics:

Database Type: Oracle Databasze 11g
Database Mame: "WinSPC

Progresz... DCIMITS
INNERNENE

< Back MHeut Cancel
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18. If you selected a language other than English in step 11 of this
section, an Add Language prompt appears once the WinSPC
schema is created. In this case:

a. Insert the language disk for the selected language into your
floppy drive and click the OK button. (Language disks are
included in your WinSPC materials. If you didn’t order a
language disk and, consequently, did not receive one, click the
Cancel button and complete the WinSPC Configuration
Wizard without adding the language. Later, you can order the
language disk and, once the disk arrives, add the language
using the Add Language option on the Administrator
window’s Tools menu in WinSPC. Until the language is added,
you’ll be restricted to running WinSPC in English. The
remainder of the WinSPC Configuration Wizard continues to
run in the selected language whether or not a language is added
from a language disk.)

b. Inthe message asking if you want to proceed with the addition
of the detected language, click OK.

c. If amessage indicating the detected language has already been
installed appears, click OK.

d. Allow the Adding New Language progress bar to complete.

e. When the You may now select the desired language in the
System Settings, Station Setup, or User Setup message
appears, click OK.

f. If the Add Language prompt reappears, click Cancel.
g. Remove the language disk from the floppy drive.
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THIS COMPLETES PHASE 2 OF 4.

GO TO CHAPTER 4: FIRST CLIENT
CONFIGURATION (FINAL STEPS) AND
COMPLETE PHASE 3.
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This chapter consists of the final steps to configure the first WinSPC
client. With a few exceptions, these steps are common to all database
servers. They begin midway through the WinSPC Configuration
Wizard, just after the creation of the WinSPC schema.

1. On the Remote Configuration Image Directory prompt:
a. Click the Browse button.

b. Inthe Directory Selection prompt that opens, navigate to and
select the shared folder created for WinSPC, then click OK.
This closes the Directory Selection prompt and populates the
Directory text box of the Remote Configuration Image
Directory prompt with the network path to the shared folder.

NOTE: The shared folder referred to here is the one created in
step 1 of the First Client Install and Configuration
(Initial Steps) section you completed prior to coming
to this chapter.
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c. Click Next.

Win5PC Configuration Wizard E

ARemote Configuration Image Directory

l
WINSFC Enter the directory where you want the rest of the

FRATIFTICAL FROCERS CONTROL WinSPC work-gtations to be configured from. Thiz
directary must be acceszible to all stations.

Drirechany:

Browse... |

MOTE: If installing for zsingle user operation, use
C:AProgram Filess\DESWYWWIRSPCARemate. Othenwize, use
a walid netwark, path.

< Back Meut » Cancel
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2. On the Remote Configuration Image Copy prompt, click Next.
This copies the necessary files to the shared folder.

WinSPC Configuration Wizard E '

Aemote Configuration Image Copy

J
WINsm A remate zetup image will now be prepared in the location

FTATHTICAL FROCESS CONTROL you zpecified. Toinitialize the remaining WinSPC
work-stations on pour network, run % inSPC.EXE from the
remate zetup directary on each wark-ztation.

Prezs Mext to continue.

< Back

Cancel |
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3. Allow the prompt’s progress bar to complete.
Win5PC Configuration Wizard E

Remote Configuration Image Copy

-
WINSFC A remate zetup image will now be prepared in the location

FRATIFICAL FROCERS CONTROL you zpecified. To initialize the remaining *WinSPC
wark-ztationg an your nebwork, iin WinSPC.EXE from the
remote zetup directory on each work-station.

Progresz...

< Back MHeut Cancel
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4. On the Custom Web Reporter Setup prompt, if you want to
install Custom Web Reporter on the first client or you think you
may, at some point, want to install and run it on an additional
client, click Next. Otherwise, click Skip and advance to step 8 of
this procedure.

WinSPC Configuration Wizard ==

Custom Web Reporter Setup

WinS P will now install the Custom 'Web Repaorter
Module, providing a full complement of advanced analysis
tolz, custom report generation and web publizhing
capabilities.

CUSTOM WEB

REPORTER

< Back Meut » Skip

Custom Web Reporter is an advanced analytics and web reporting
package that can be used with WinSPC. A free 60-day license for
it comes with the purchase of WinSPC. For information on
purchasing permanent licenses, contact DataNet Quality Systems
at 1-866-4WINSPC.
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5. On the Statit(r) Licensing Information prompt, read the license
agreement and, if you agree, click I Agree.

Statit(r) Licensing Informaticon

LICEMSE AGREEMEMT AMD LIMITED wWaRRANTY -

m

Pleaze carefully read thiz agreement before uzing the zoftware being
provided to you by Statware, [ncorparated. Uzing the zoftware indicates
your acceptance of this agreement. [F you do not agree to all of the terms
and conditions of thiz icenze, you must dizcontinue use of the software,
removing any content nzstalled on your syster(z], and returming any media,
packaging and accompanying items [including written materialz] within 30
days of your purchase. You must alzo include a letter confirming that you
have discontinued use of the software and are requesting a refund. On
meeting these obligations, your money will be refunded.

|n conzideration of the payment of the per copy licenze fee, Statware,
|ncorporated [ 'Statware'"] grants to wou a license to uze the Software
under the following terms and conditions.

1. DEFIMITIONS.

a. "Software' refers to the software accompanying this Licenze together
with all accompanying documentation and manuals and any updates and
future software provided to pou by Statware or a Statware authorized
reseller.

b, "vou" means the corporation, partnership or individual which or who

4 | 1 »

| Disagree
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6. On this Custom Web Reporter Setup prompt, click Next. This
installs Custom Web Reporter on the first client and copies the
installation files for Custom Web Reporter to the shared folder.

WinSPC Configuration Wizard ==

Custom Web Reporter Setup

Custom *'eb Reparter will now be installed for use with
WinSPC.

Press Hext to continue.

< Back

Cancel |
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7. Allow the prompt’s progress bar to complete.
Win5PC Configuration Wizard E

Custom Web Reporter Setup

Custom *'eb Reparter will now be installed for use with
WinSPC.

Progresz...

[

< Back MHeut Cancel
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8. On the System Administrator Password prompt, create and enter
a sufficiently strong, case-sensitive password for the WinSPC
Admin user in both the Password and Confirm Password text
boxes. Then, click Next.

Win5PC Configuration Wizard

System Administrator Password

An adminiztratar uzer has been created for you, 1F pau
chiooze, pau may azsign a pazesword to restict access to
thiz uzer login.

IJzer Mame:
Admin

Pazgwiord:

Confirm Pazsword:

< Back

Cancel |

NOTE: This Admin user is the only user with complete WinSPC
permissions.
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9. On the Finished prompt that appears, click Finish. This causes
the WinSPC Configuration Wizard to close.

Win5PC Configuration Wizard E

Finizhed!

WINsm Thiz completes the inztallation of WinSPC.

MTATINTHCAL FRIOCERS CORTRCH.

< Back

Cancel |
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It also causes the WinSPC Access Center to open.

WinSPC Access Center - Station: CLIEMTL
Uzer Mame:
| Lol
Pazsward:
Help
E xit Ahout...

10. In the Access Center, click the Exit button.

11. If your first client is the Microsoft Terminal Services server: (
a. Navigate to and double-click winspc.ini. The default "L'
installation location for this file is C:\Program Files > DQS > -

WinSPC > winspc.ini.
b. Insert a blank line directly below this file’s [System] heading.

Terminal Services
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c. On that line, enter TerminalServices=1. This informs WinSPC
at startup that the environment is a Microsoft Terminal
Services environment.

[P WinSPC.ini - Notepad =10 x|
File Edit Format Miew Help

[System] =]
erminalservices=1

ImageType=L0oca

version=80000

DriverType=2
Imagebir="“TestserverswinsPCRemotey

Mo Local DE=mMo Tocal database available. U
Mo online Until wvalid rRemotes=svou will not b
Databhase Unawvailabhle=Catabase unavailahle.
Remote Image Directory Location=Remote Ima
working OF%1ine=Netwurk connection not avail
off1ine warning=This station has now failed
StationMame=TERMINALSERWVER

[aDo Params]

Provider=SoL0OLEDE. 1

Lata source=TEZTZERVER

Initial Catalog=winsrc

Connection Timeout=0

UID=J0HMDOE

Persist Security Info=True
PWD=MSMTE,/Z5E21 3 zvhESk BugSkPhRDaOZ P Sy 0+hGED

w,

1 | Ay

d. Indicate whether WinSPC is to name stations based on the
connecting station or the connecting user. This is done by
specifying either station mode or user mode as the mode in
which WinSPC is to run. In station mode, WinSPC uses the ID
of the station RDPing into the Microsoft Terminal Services
server as the station name. In user mode, WinSPC uses the ID
of the user (i.e. the login ID with which a user logs into
Windows on the Microsoft Terminal Services server via a RDP
session) as the station name. For example, say Bob logs into a

140 ‘ ‘Insta//at/on and Configuration Guide



Chapter 4: First Client Configuration (Final Steps)

station named Finishing and then, via RDP, logs into the
Microsoft Terminal Services server as Sally. With station mode
enabled, WinSPC will use Finishing as the station name. With
user mode enabled, WinSPC will use Sally as the station name.
Station mode is the default mode in which WinSPC runs and,
consequently, nothing needs to be done to enable it. To enable
user mode, directly beneath the TerminalServices=1 line
entered in the preceding step, enter a UserMode=1 line.

NOTE: To disable user mode in the future and have WinSPC
run in station mode, delete the UserMode=1 line or
change it to UserMode=0.

If you enabled user mode in the preceding step, configure
Microsoft Terminal Services to disallow simultaneous sessions
from a user. To do this:

i. On the Microsoft Terminal Services server, launch
Terminal Services Configuration, the default path for
which in Windows Server 2003 is Start > All Programs >
Administrative Tools > Terminal Services
Configuration.

ii. In the left pane of the Terminal Services Configuration
prompt, single-click the Server Settings folder.

iii. In the right pane, right-click Restrict each user to one
session and, from the shortcut menu that appears, click
Yes.

iv. Close Terminal Services Configuration.
Save and close winspc.ini.
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NOTE: The remaining steps of this procedure concern granting
permissions for users of WinSPC on the first client. The
permissions granted by these steps are the minimum
permissions required to run WinSPC. These steps assume
your WinSPC implementation employs network domains. If
your implementation employs workgroups, instead of
completing these steps, complete Appendix C: WinSPC
Security for Workgroups.

12. If you are logged into Windows on the first WinSPC client
machine as anything other than a domain administrator, log out
and log back in as a domain administrator. (This is necessary
because you will be creating a user group for WinSPC users on the
domain controller.)

13. Navigate to the shared folder created for WinSPC and, within this
folder’s Utility folder, double-click WinSPCSecurity.

% WinSPCSecu rity

14. In the WInSPC Security utility that launches, toward the bottom
of the Groups tab, at Group Name, enter a name for a user group
that will consist of WinSPC users. (The recommended name for
this user group is WinSPC Users.)
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WinSPC Security - TESTDOMAIN ==

Groups | Users |

The following iz a lizt of all user groups that exist within pour Windows
domain. Users that are memberz of ane of the checked groups have
all the neceszan permizzions to run 'WinSPC. Click the check boxes
niest to the items to grant WinsPC permiszions to additional groups or
to remove WinSPC permizsions from groups.

TESTDOMAINSDnel)pdatePromy
TESTDOMAIMDamain Admins
TESTDOMAIMDomain Compliters
TESTDOMAIMSDamain Contrallers
TESTDOMAIM D amain Guests
TESTDOMAIMSDamain Users
TESTDOMAIMAE nterprize Admins
TESTDOMAIMGroup Palicy Creatar Dwners
TESTDOMAINYS chema &dminz

Group Mame:
WinSPC Users Create Mew Group | Apply Updates
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15. Click the Create New Group button.

Create Mew Group

This causes the user group to be added to the list of groups above
and creates the user group on the domain controller.

16. Check the check box for the new user group.
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| WinSPC Security - TESTDOMAIN ==
Groups | Users |

The following iz a list of all uzer groups that exist within wour Windows
domain. Uszers that are members of ane of the checked groups have
all the neceszsary permizzions bo run WinSPC. Click the check boxes
next o the ikems to grant W inSPC permizzions to additional groups or
to remove WinSPC permizsions from groupes.

TESTDOMMAIMDnel ) pdateProxy
TESTDOMAIMDomain Admins
TESTDOMAIMDamain Compliters
TESTDOMAINSDomain Controllers
TESTDOMAIMSD amain Guests
TESTDOMAIMNYDomain Uszers
TESTDOMMAIMSE nterprize Admins
TESTDOMAIMNGroup Policy Creatar Dwners
TESTDOMAIMNYS chema Adminz

Pl TESTDOMAIMNYWIRSPC Uzers

Group Marne:
WinSPC Llsers Create Mew Group | Apply Updates
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17. Click the Apply Updates button.

Apply Updates

This causes an Applying Permissions progress bar to appear.

Applying Permissions - TESTDOMAINYWInSPC Users

18. When the Applying Permissions progress bar closes, close the
Security Utility by clicking the X in the upper right corner.

19. Close the window showing the contents of the Utility folder.

20. If the first client’s operating system is Windows 7 or Vista and you
wish to enable UAC, do so. Please note that there are a limited
number of functions which WinSPC is unable to perform with
UAC enabled. For more information, see Appendix H.

21. Grant the user group for WinSPC users at least the minimum
required permissions to the shared folder. For file servers running
Windows Server 2003, the minimum Share permissions are
Change and the minimum Security permissions are Modify. For
file servers running Windows Server 2008, the minimum Share
permissions are Contributor and the minimum Security
permissions are Modify. For a procedure on granting permissions,
see Appendix D: Granting Share and Security Permissions.

22. On your domain controller, add all local administrators who will
install and configure WinSPC on additional clients and all domain
users who, on any client, will be running WinSPC to the newly
created user group. For a procedure on adding users to a user
group, see Appendix E: Adding Users to a User Group.
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THIS COMPLETES PHASE 3 OF 4.

GO TO CHAPTER 5: ADDITIONAL CLIENT
INSTALLS AND CONFIGURATIONS AND
COMPLETE PHASE 4.

IF YOU DON’T NEED TO INSTALL AND
CONFIGURE WINSPC ON ADDITIONAL CLIENTS,
THIS CONCLUDES THE ENTIRETY OF THE SETUP

REQUIRED TO BEGIN USING WINSPC. FOR
INSTRUCTIONS ON LAUNCHING AND LOGGING
INTO WINSPC, SEE APPENDIX F: LAUNCHING
AND LOGGING INTO WINSPC.
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CHAPTER 5: ADDITIONAL CLIENT INSTALLS AND
CONFIGURATIONS

If your WinSPC implementation utilizes the conventional client/server
architecture exclusively, meaning it does not employ Microsoft
Terminal Services at all, complete the procedure in this chapter on
each additional client station that is to run WinSPC.

If your implementation utilizes Microsoft Terminal Services
exclusively, meaning all client stations other than the Microsoft
Terminal Services server connect to the WinSPC database through the
Microsoft Terminal Services server, it is not necessary to complete the
procedure in this chapter.

If your implementation employs a mix of the conventional
client/server architecture and a Microsoft Terminal Services
architecture, complete this chapter for any client station that will be
connecting to the WinSPC database directly rather than through the
Microsoft Terminal Services server. This includes completing the
procedure on the Microsoft Terminal Services server itself if WinSPC
was not installed on this server as part of the first client configuration.

1. Log into Windows on the additional client machine as a local
administrator.

2. If the operating system on the additional client is Windows 7 or
Vista, disable User Account Control (UAC). Refer to Appendix H
for instructions on doing this.

3. Using Windows Explorer, navigate to the shared folder created for
WIinSPC and double-click WinSPClnstall.exe.

") WinSPCinstall

Phase 4 of 4
I

‘A

Terminal Services
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4. Complete the WinSPC Installation Wizard. For detailed
information on this prompt, see Appendix A: The WinSPC
Installation Wizard.

5. Launch and exit WinSPC once while logged into Windows as a
local administrator. To do this:

a. Click WIinSPC. The default path for this is Start > All
Programs > WinSPC.

b. Inthe WIinSPC Access Center that appears, click the Exit

button.
WinSPC Access Center - Station: CLIENT2
Uzer Mame:
|| Logln
Pazsward:
Help
E xit Ahout...
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6. If you don’t want to install Custom Web Reporter on the additional
client, go to step 7. If you want to install Custom Web Reporter:

a. Navigate to the shared folder for WinSPC.

b. In the shared folder’s STATIT subfolder, double-click
CustomQC5410EM.exe. When the Installing progress bar
that appears closes, the Custom Web Reporter installation is

complete.

Installing ==

Copying file:
C:AProgram FileshStatit 5 41 \hwperhelptcpmdzktp hip

-

NOTE: Forthe STATIT subfolder to exist in the shared folder,
Custom Web Reporter must have been installed during
the first client configuration. If this was not the case and
you want to install Custom Web Reporter on the
additional client, contact DataNet Quality System’s
Product Support Help Desk at (248)-447-0140.

7. If the additional client is your Microsoft Terminal Services server: (

a. Navigate to and double-click winspc.ini. The default WL
installation location for this file is C:\Program Files > DQS > . —

WinSPC > winspc.ini.
b. Insert a blank line directly below this file’s [System] heading.

Terminal Services
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c. On that line, enter TerminalServices=1. This informs WinSPC
at startup that the environment is a Terminal Services
environment.

[P WinSPC.ini - Notepad =10 x|
File Edit Format Miew Help

[System] =]
erminalservices=1

ImageType=L0oca

version=80000

DriverType=2
Imagebir="“TestserverswinsPCRemotey

Mo Local DE=mMo Tocal database available. U
Mo online Until wvalid rRemotes=svou will not b
Databhase Unawvailabhle=Catabase unavailahle.
Remote Image Directory Location=Remote Ima
working OF%1ine=Netwurk connection not avail
off1ine warning=This station has now failed
StationMame=TERMINALSERWVER

[aDo Params]

Provider=SoL0OLEDE. 1

Lata source=TEZTZERVER

Initial Catalog=winsrc

Connection Timeout=0

UID=J0HMDOE

Persist Security Info=True
PWD=MSMTE,/Z5E21 3 zvhESk BugSkPhRDaOZ P Sy 0+hGED

w,

1 | Ay

d. Indicate whether WinSPC is to name stations based on the
connecting station or the connecting user. This is done by
specifying either station mode or user mode as the mode in
which WinSPC is to run. In station mode, WinSPC uses the ID
of the station RDPing into the Microsoft Terminal Services
server as the station name. In user mode, WinSPC uses the ID
of the user (i.e. the login ID with which a user logs into
Windows on the Microsoft Terminal Services server via a RDP
session) as the station name. For example, say Bob logs into a
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station named Finishing and then, via RDP, logs into the
Microsoft Terminal Services server as Sally. With station mode
enabled, WinSPC will use Finishing as the station name. With
user mode enabled, WinSPC will use Sally as the station name.
Station mode is the default mode in which WinSPC runs and,
consequently, nothing needs to be done to enable it. To enable
user mode, directly beneath the TerminalServices=1 line
entered in the preceding step, enter a UserMode=1 line.

NOTE: To disable user mode in the future and have WinSPC
run in station mode, delete the UserMode=1 line or
change this line to UserMode=0.

If you enabled user mode in the preceding step, configure
Microsoft Terminal Services to disallow simultaneous sessions
from a user. To do this:

i. On the Microsoft Terminal Services server, launch
Terminal Services Configuration, the default path for
which in Windows Server 2003 is Start > All Programs >
Administrative Tools > Terminal Services
Configuration.

ii. In the left pane of the Terminal Services Configuration
prompt, single-click the Server Settings folder.

iii. In the right pane, right-click Restrict each user to one
session and, from the shortcut menu that appears, click
Yes.

iv. Close Terminal Services Configuration.
Save and close winspc.ini.
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8. Complete Appendix B: Installing NJWin for an Asian
Language if the additional client machine will need to run
WinSPC in an Asian language.

NOTE: The remaining steps of this procedure concern granting
permissions for WinSPC users on the additional client
machine. The permissions granted are the minimum
permissions required to run WinSPC. These steps assume
your WinSPC implementation employs network domains. If
your implementation employs workgroups, instead of
completing these steps, complete Appendix C: WinSPC
Security for Workgroups.

(These steps and Appendix C can be disregarded if every
user of the WinSPC client has local administrator privileges
on the client machine. In such a case, close the WinSPC
shared folder and see Appendix F: Launching and Logging
Into WinSPC to begin using WinSPC.)

9. Within the WinSPC shared folder, double-click Utility >
WinSPCSecurity.

¥ WinSPCSecurity
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10. In the message indicating the application (i.e. security utility) may
not run properly if you are not logged into Windows as an
administrator, click Yes. (The administrator referred to in this
message is a domain administrator. Being logged in as a local
administrator, however, is sufficient for the remainder of this

procedure.)

(=5

Error

( s 1 This applicaticn may not run properly if you are not logged inte Windows as the administrator,
Do you wish to continue?

11. In the WIinSPC Security utility, on the Groups tab, check the
check box that corresponds to the name of the user group created
for WinSPC users. This name was entered in step 14 of Chapter

4: First Client Configuration (Final Steps).
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WinSPC Security - TESTDOMAIN (3]

Groups | Users |

The following iz a lizt of all user groups that exist within pour Windows
domain. Users that are memberz of ane of the checked groups have
all the neceszan permizzions to run 'WinSPC. Click the check boxes
niest to the items to grant WinsPC permiszions to additional groups or
to remove WinSPC permizsions from groups.

TESTDOMAINSDnel)pdatePromy
TESTDOMAIMDamain Admins
TESTDOMAIMDomain Compliters
TESTDOMAIMSDamain Contrallers
TESTDOMAIM D amain Guests
TESTDOMAIMSDamain Users
TESTDOMAIMAE nterprize Admins
TESTDOMAIMGroup Palicy Creatar Dwners
TESTDOMAINYS chema &dminz:

ol TESTDOMAIMNYWIRSPC zers

Group Marme:

| Create Mew Group | Apply Updates
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12. Click the Apply Updates button.

Apply Updates

This causes an Applying Permissions progress bar to appear.

Applying Permissions - TESTDOMAINYWInSPC Users ]

13. When the Applying Permissions progress bar closes, close the
Security Utility by clicking the X in its upper right corner.

14. If the additional client’s operating system is Windows 7 or Vista
and you wish to enable UAC, do so. Please note that there are a
limited number of functions which WinSPC is unable to perform
with UAC enabled. For more information, see Appendix H.

15. Close the window showing the contents of the Utility folder.

16. If the additional client station will be used by any users who were
not added to the user group for WinSPC users created during the
first client configuration process, go to the domain controller and
add them. (For a procedure on adding users to a user group, see
Appendix E: Adding Users to a User Group.)
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THIS COMPLETES PHASE 4 OF 4.

NO FURTHER SETUP IS REQUIRED TO BEGIN
USING WINSPC. FOR INSTRUCTIONS ON
LAUNCHING AND LOGGING INTO WINSPC, SEE
APPENDIX F: LAUNCHING AND LOGGING INTO
WINSPC.
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APPENDIX A: THE WINSPC INSTALLATION
WIZARD

This appendix details the prompts encountered in the WinSPC
Installation Wizard.

1. On the first prompt of the WinSPC Installation Wizard, click Next.
77 WinsPC Installation Wizard s

If ome or mare Windows programs are running, please click the
Cancel button below, cloze each unning Windows program and
then restart this installation.

Thiz program iz protected by copyright law and international
treaties. Copyright 2003 D atanet Quality Systems.

Cancel |
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2. Onthe License Agreement and Limited Warranty prompt, read
the agreement and, if you accept its terms, click Yes.

£ WinSPC Installation Wizard

License Agreement and Limited Warranty

.-'

il

A

LICEWSE AGREEMEMT AND LIMITED WARRAHTY

[MPORTAMT -- Carefully read the following terms and conditions of thiz License
Agreement and Limited W arranty [“Agreement'] prior to opening, installing, copying ar
uzing the accompanying software program(s], associated media or printed documentation
[collectyvely refered to ag the 'S oftware Product™). If you do not agree with the terms and
conditions contained herein, promptly reburn all components of the Software Product to
the place of purchasge or to Dataket Cluality Spetemsz [“Dataket'’]. By opening, inztalling,
copying or uging the Software Product, you agree to be bound by the termsz and
conditions of this Agreement.

Click ez if you accept the terms of the license agreement and limited warranty. Click Mo to
close the WinSPC Installation Wizard

Wize Inztallation Wizard®
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3. On the Installation Folder prompt, accept the default installation
folder and click Next or click Browse, select a different folder and
click Next. (The installation folder is the folder into which
WinSPC will be installed.)

£ WinSPC Installation Wizard

i

Installation Folder

'.,
A

Ingtallation Folder

C:A%Program Files\DASYWwinSPC Browse...

Ta Change the folder into which WinSPC will be installed, click the Brovwese button, navigate
to and double-click the desired installation folder

Wize [nstallation Wizard®

< Back Cancel
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4. On the Install WinSPC prompt, click Next.

4 WinSPC Installation Wizard
Install WinSPC

Thank you. That iz all the information required toinstall WinSPC. Click Mest bo continue.

Wize Inztallation \Wizard®

Cancel

¢ Back
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5. Allow the installation to occur.

WinSPC

Inztalling

=

— Current File

Copying file:
C:A\Program FileshDQSYWwWinSPCAR avehRvGraphics70.bpl

— &l Files

Time Remaining 0 minutes 30 seconds

Wize [nstallation Wizard

< Back MHext » | Cancel I
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6. When the installation completes, click Finish.

Win5PC Installation Wizard

B . T S0
WinSPC haz been successfully installed.
J P‘
' Your next step iz to launch WinSPC. The default path to do this
. iz Starty Pragrams»win3S PCyWwWinSPC.

< Back

Cancel |

THIS COMPLETES APPENDIX A.

RETURN TO AND COMPLETE THE FIRST CLIENT
INSTALL AND CONFIGURATION (INITIAL
STEPS) SECTION OF THE CHAPTER YOU WERE ON
BEFORE COMING TO THIS APPENDIX.
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APPENDIX B: INSTALLING NJWIN FOR AN
ASIAN LANGUAGE

Complete this appendix if you want to run WinSPC or the WinSPC
Configuration Wizard in an Asian language on a client machine that is
running a Romance-language version of Microsoft Windows.

As you may know, Microsoft Windows is available in several sets of
languages. One of these sets is the Romance set, a set which includes
the English language. When some non-Romance language translations
of WinSPC, Asian language translations particularly, are run on a
Romance-language version of Windows, the characters of the WinSPC
translation are improperly displayed. Installing and running NJWin
remedies this for an Asian language. (The East Asian language set of
Microsoft Windows may not require NJWin.)

For your convenience, a trial version of NJWin is included on the
WInSPC CD. If you install and like this trial version, you can purchase
a license at www.njstar.com.

1. Copy the NJWin executable to the WinSPC shared folder. To do
this:

a. If you downloaded your WinSPC Version 8 installation
materials from www.winspc.com:

i. Right-click the downloaded zip file and select WinZIP >
Open with WinZIP.

ii. In the WinZIP window that appears, single-click the Name
heading at the top of the Name column. This lists the files in
the column in descending alphabetical order.

iii.Scroll down the Name column until you locate the
njwin183.exe file.
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iv. Right-click this file and select Copy.
v. Navigate to the shared folder for WinSPC.
vi.Right-click this folder and select Paste.

b. If you received your WinSPC Version 8.0 materials on CD:

i. With the CD in your CD-ROM drive, right-click Computer
(Vista) or My Computer (XP) and click Explore.

ii. In the window that appears, right-click your CD-ROM drive
and click Explore.

iii.Double-click the Extra Files folder.

iv. Double-click the NJWin folder.

v. Right-click njwin183.exe and select copy.

vi. Navigate to the WinSPC shared folder.
vii.Right-click the shared folder and select Paste.

NOTE: Completing this step (i.e. 1a or 1b), which eliminates the
need to bring the WinSPC CD to each client machine on
which NJWin is to be installed, only needs to be done
once.

2. From a client machine on which you want to install NJWin,
navigate to the shared folder and double-click njwin183.exe.
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3. When the Welcome prompt of the NJWin setup wizard appears,
click Next.

NJWIN - NJStar CJK Viewer 1.83 Shareware Setup A=

Welcomel

welcome to the MIWIMN - MJStar CIK Viewer setup wizard, This
wizard will install MJWIRN - MdStar CIE Yiewer on pour system.

It iz recommended that you exit all ather applications before starting.
Fresz ALT+TAB to awitch to other applications, save pour work,
and cloze each application.

Frez: Mext when pou are ready to begin.

Cancel
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4. Read the License Agreement and, if you agree, click Next.

JWIN - NJStar CJK Viewer 1.83 Shareware Setup =1

License Agreement

Please read the following license agreement. IF you accept the
terms of thiz agreement, presz Next. If you do not accept, press
Cancel to exit setup.

Thank you for trying NTWIN - the %
NIStar CTK Multilingual Viewer

With this shareware version, you are granted a
limited license for 30 days trial of NJStar
software. If you would like to continue using

this software after 30 days trial period, you —
must purchase a registered version. Registered
version provides better fonts for printing and

dienlaw full hilinanal dictinnans and fraa

< Back | Mext > | Cancel
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5. Specify the folder to which you want the NJWin application files
copied and click Next.

JWIN - NJStar CJK Viewer 1.83 Shareware Setup A=

Select application folder

Ilze the field below to zpecity the folder where you want the
application files to be copied to.

To specify a different folder, bype a new name, or uge the Browse
button to zelect an existing folder.

Fresz Mext to continue.

C:“Program FilesiMJ Star CIE Yiews g

¢ Back | Mext = | Cancel
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6. When the Ready prompt appears, click Next. This installs NJWin.

HJWIN - HJStar CJK Viewer 1.83 Shareware Setup

Ready

Setup Wizard now haz enough information ta set up NJWIN -
MJStar CIK. Yiewer on your compuker.

Fres: Back to review your settings or Next to continue.

< Back | Mewt > | Cancel
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7. On the Setup was successful prompt, click Close.

2 NJWIN - NJStar CJK Viewer 1.83 Shareware Setup A=

Setup was successful

MM - MU Star CE Wiewer was successfully set up on your
camputer,

Frezs Close to exit setup.

| | LCloze
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8. Onthe NJWIN — NJStar CJIK Viewer prompt that is displayed,
select the Asian language in which you intend to run WinSPC (or
the WinSPC Configuration Wizard) and click OK. This closes the
viewer and launches NJWin. (See the First Client Install and
Configuration (Initial Steps) section of the chapter specific to
your database server for information on the WinSPC Configuration
Wizard.)

HJWIN - MJStar CJK Viewer E|

el
ﬂ] Pleaze zelect vour defaut language:

* Chinesze Simplified
" Chineze Traditional

" Japanese

" Korean

Ok
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9. Close the NJWin — NJStar CJK Viewer folder.
10. Close the WinSPC shared folder.

NOTE: NJWin must be running when WinSPC is running for
WIinSPC to properly display Asian language characters. If
the operating system of the client machine on which NJWin
is installed is Windows XP Pro and the default storage
location was accepted during the installation procedure,
NJWin can be launched by clicking Start > All Programs >
NJWIN — NJStar CIK Viewer > NJWIN — NJStar CIK
Viewer. Alternatively, WinSPC can be set up to launch
NJWin automatically. This is accomplished through the Use
NJWin check box, a check box found on the setup prompts
for system settings, station groups, stations, user groups and
users. See WinSPC’s Help for more information on this
check box. (If you’re ever in doubt as to whether or not
NJWin is running, press <Ctrl+Alt+Del> and check the
Applications tab of the Task Manager.)

THIS COMPLETES APPENDIX B.

RETURN TO AND COMPLETE THE PROCEDURE
YOU WERE WORKING ON PRIOR TO COMING TO
THIS APPENDIX.
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APPENDIX C: WINSPC SECURITY FOR
WORKGROUPS

This appendix details the procedure for granting permissions to
WIinSPC users on a client machine that is part of a workgroup as
opposed to a domain. The permissions granted are the minimum
permissions required to run WinSPC. It is to be completed after step
11 of Chapter 4: First Client Configuration (Final Steps) or after
step 7 of Chapter 5: Additional Client Installs and Configurations.

1. Navigate to the WinSPC shared folder created during the
installation and configuration of the first WinSPC client.

2. Double-click the Utility folder.
3. Within the Utility folder, double-click the WinSPCSecurity icon.
% WinSPCSecurity

Installation and Configuration Guide ‘ ‘ 175



Appendix C: WinSPC Security for Workgroups

4. If an error message indicating the application (i.e. security utility)
may not run properly if you are not logged into Windows as an
administrator appears, click Yes. (The administrator referred to in
this message is a domain administrator. Being logged in as a local
administrator, however, is sufficient for this procedure.)

X5

Error

f - h This applicaticn may net run preperly if you are not logged inte Windows as the administrator,
Do you wish to centinue?

5. In the WIinSPC Security utility that appears, on the Users tab,
click the Refresh User List button.
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WinSPC Security - (ho domain) (3]

The following iz a lizt of all users that exist on this local machine and
within wour Windows domain. Users that are checked have all the
neceszany permizsions bo run wWinSPC. Click the check boxes nest to
thie itemz to grant WWinSPC permiszions to additional uzers or to
remove YWinSPC permissions from wsers.

Groups

Apply Updates Refrezh User List
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6. Check the check box for each user you want to be able to run
WIinSPC on the client station.
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=5

WinSPC Security - (ho domain)

Groups lzers |

The following iz a lizt of all users that exist on thiz lacal machine and
within wour Windows domain.  Users that are checked have all the
neceszany permizsions bo run wWinSPC. Click the check boxes nest to

thie itemz to grant “WinSPC permiszions to additional uzers or ko
remove YWinSPC permissions from wsers.

| CLIEMT 1 Administrator
CLIEMT 1\ Guest
(4l CLIEMT 1M ocaluzer

Apply Updates Refrezh User List
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7. Click the Apply Updates button. This causes a progress bar to
appear.

Applying Permissions - CLIEMTLVAdministrator

8. Once permissions are applied to all selected users, exit the
WIinSPC Security utility by clicking the X in the upper right
corner. (Later, if you wish to remove previously applied
permissions, simply uncheck the appropriate check box and click
the Apply Updates button.)

9. Close the Utility folder.

THIS COMPLETES APPENDIX C.

IF YOU NEED TO INSTALL AND CONFIGURE
ADDITIONAL CLIENTS, GO TO CHAPTER 5:
ADDITIONAL CLIENT INSTALLS AND
CONFIGURATIONS AND COMPLETE PHASE 4.

IF YOU DON’T NEED TO INSTALL AND
CONFIGURE ADDITIONAL CLIENTS, THIS
CONCLUDES THE ENTIRETY OF THE SETUP
REQUIRED TO BEGIN USING WINSPC. FOR
INSTRUCTIONS ON LAUNCHING AND LOGGING
INTO WINSPC, SEE APPENDIX F: LAUNCHING
AND LOGGING INTO WINSPC.
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APPENDIX D: GRANTING SHARE AND
SECURITY PERMISSIONS

This appendix details one method of granting a user or user group
Share permissions to a folder and one method of granting a user or
user group Security permissions to a file or folder. These methods are
applicable to both Windows Server 2003 and Windows XP Pro.

To GRANT SHARE PERMISSIONS TO A FOLDER

1. Log into Windows on the computer containing the folder to which
you want to grant Share permissions as an administrator with
sufficient privileges to grant permissions.

2. Using Windows Explorer, navigate to and right-click the file or
folder to which you want to grant Share permissions and, from the
shortcut menu, select Sharing and Security.

3. On the Sharing tab of the <Folder Name> Properties prompt that
is displayed, select the Share this Folder option, if it isn’t already
selected.

4. Click the Permissions button.

In the Permissions for <Folder Name> prompt, click the Add
button.

6. Inthe Select Users, Computers, or Groups prompt that appears,
enter the first letter of the user or user group to whom you want to
grant Share permissions and click OK.

7. If a Multiple Names Found prompt is displayed, locate and
double-click the user or user group.
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10.

11.

With the user or user group selected in the Permissions for
<Folder Name> prompt, in the bottom pane, single-click the
Allow check box for the desired permissions.

Click OK.

If you also want to grant Security permissions for the folder, click
the Security tab in the <Folder Name> Properties prompt and,
beginning at step 4 below, complete the To Grant Security
Permissions to a Folder or File procedure.

If you don’t want to grant Security permissions for the folder, click
OK in the <Folder Name> Properties prompt.

To GRANT SECURITY PERMISSIONS TO A FOLDER OR FILE

1.

Log into Windows on the computer containing the folder or file to
which you want to grant Security permissions as an administrator
with sufficient privileges to grant permissions.

Using Windows Explorer, navigate to and right-click the folder or
file to which you want to grant Security permissions and, from the
shortcut menu, select Properties.

In the <Folder Name> Properties prompt that is displayed, click
the Security tab.

On the Security tab, click the Add button.

In the Select Users, Computers, or Groups prompt that appears,
enter the first letter of the user or user group to whom you want to
grant Security permissions and click OK.

If a Multiple Names Found prompt is displayed, locate and
double-click the user or user group.
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7. With the user or user group selected in the top pane of the Security
tab, single-click the Allow check box for the desired permissions
in the bottom pane.

8. Ifitis a folder to which you’ve just granted Security permissions
and you need to propagate those permissions to the folder’s child
folders and files:

a. On the Security tab, with the user or user group still selected,
click the Advanced button.

b. Check the check box labeled Replace permission entries on
all child objects with entries shown here that apply to child
objects.

c. Click Apply.

d. Inthe Security warning that is displayed, click Yes. This
initiates the propagation of permissions to child folders and
files.

e. When the propagation completes, click the Advanced Security
Settings for <Folder Name> prompt’s OK button.

9. Click OK in the <Folder Name> Properties prompt.

THIS COMPLETES APPENDIX D.

RETURN TO AND COMPLETE THE PROCEDURE
YOU WERE WORKING ON PRIOR TO COMING TO
THIS APPENDIX.
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APPENDIX E: ADDING USERS TO A USER
GROUP

This appendix details one method of adding users to a user group on a
domain controller. It applies to Windows Server 2003.

1. On your domain controller, click Start > Administrative Tools >
Active Directory Users and Computers.

2. Inthe left pane of the Active Directory Users and Computers
prompt that appears, expand the node for the domain used for your
WinSPC implementation.

3. Single-click Users.
4. In the right pane:

a. Multi-select all users who will run WinSPC and all local
administrators who will install and configure WinSPC.

b. Right-click any of the selected users and, from the shortcut
menu, select Add to a group.

5. Inthe Select Group prompt, enter the first letter of the user group
to which you want to add the users and click OK.

6. If a Multiple Names Found prompt appears, double-click the user
group.

7. In the message indicating that the Add to Group operation was
successfully completed, click OK.

8. Close the Active Directory Users and Computers prompt.
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THIS COMPLETES APPENDIX E.

GO TO CHAPTER 5: ADDITIONAL CLIENT
INSTALLS AND CONFIGURATIONS AND
COMPLETE PHASE 4.

IF YOU DON’T NEED TO INSTALL AND
CONFIGURE ADDITIONAL CLIENTS, THIS
CONCLUDES THE ENTIRETY OF THE SETUP
REQUIRED TO BEGIN USING WINSPC. FOR
INSTRUCTIONS ON LAUNCHING AND LOGGING
INTO WINSPC, SEE APPENDIX F: LAUNCHING
AND LOGGING INTO WINSPC.
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APPENDIX F: LAUNCHING AND LOGGING
INTO WINSPC
If you are launching WinSPC in a Microsoft Terminal Services

environment, connect to the Microsoft Terminal Services server using C’
Remote Desktop before beginning this procedure. 5

1. From the client machine, run WinSPC. The default path for doing
this is Start > All Programs > WinSPC > WinSPC. Terminal Services

2. Inthe WIinSPC Access Center that is displayed:
a. At User Name, enter a valid user name

NOTE: |If this is the first time WinSPC is being logged into,
the only valid user name is Admin.

b. At Password, enter the password associated with the user
name entered above.

NOTE: The password for the Admin user is the password
created in step 8 of Chapter 4: First Client
Configuration (Final Steps).
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c. Click Log In.
WinSPC C/S Access Center - Station: Test1
zer Mame:
|admin Logln
Pazaword;

Help

PLE

E xit | About...

d. If a message appears indicating that you have one or more
unread messages, click OK.

NOTE: For help on using WinSPC, see WinSPC’s context sensitive
Help system. This Help system can be accessed from within
WIinSPC by clicking a Help button wherever one appears,
pressing the F1 key or selecting Contents from the Help
menu.

THIS COMPLETES APPENDIX F.
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APPENDIX G: HARDWARE REQUIREMENTS
AND RECOMMENDED
PLATFORMS

This appendix is provided to assist companies in the selection of
hardware, operating systems and a database server for their WinSPC
implementation. It consists of two sections, one for each of the
architectures that can be adopted for WinSPC. These architectures are:

= Conventional Client/Server Architecture
=  Microsoft Terminal Services Architecture

NOTE: The absence of an operating system or database server from
any of the below lists means that the operating system or
database server is not tested in DataNet Quality Systems’ lab.
It does not mean that the operating system or database server
Is known to be incompatible with WinSPC or that DataNet
Quality Systems will not do its best to support
implementations using the operating system or database
server.
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CONVENTIONAL CLIENT/SERVER ARCHITECTURE

Minimum Hardware Requirements

Client Stations

Database Server

= 1 GHz or faster 32-bit or 64-bit
processor

= 1 GB RAM (if 32-bit) or 2 GB RAM
(if 64-bit) for a typical Windows 7
station

= 1 GB RAM for a typical Windows
Vista Business station*

= 256 MB RAM for a typical Windows
XP Pro*

= 200MB available local hard disk space
(beyond operating system
recommended space)

= VGA monitor and video adapter

= Keyboard

= Mouse or other pointing device

= CD-ROM or DVD-ROM drive (if
installing WinSPC from the WinSPC
CD as opposed to the web download)

* By typical is meant a default operating
system install and no other heavy
RAM-consuming applications
running.

= Server Class processor —
800MHz

» 512MB available RAM

» 10GB available local hard disk
space (beyond operating system
recommended space)

= VGA monitor and video adapter

= Keyboard

= Mouse or other pointing device

» CD-ROM or DVD-ROM drive

NOTE: For a method to estimate
database storage needs
based on data specific to
your company, see the
How to Estimate
Database Storage
Requirements section at
the end of this appendix.
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Recommended Platforms

Server Operating
System

Database Server

Client Operating
System

Windows Server
2008

Microsoft SQL Server 2008

Windows 7 Pro

Windows Server
2008

Microsoft SQL Server 2008

Windows Vista
Business

Windows Server
2008

Microsoft SQL Server 2008

Windows XP Pro

Windows Server
2008

Microsoft SQL Server 2008
Express

Windows 7 Pro

Windows Server
2008

Microsoft SQL Server 2008
Express

Windows Vista
Business

Windows Server
2008

Microsoft SQL Server 2008
Express

Windows XP Pro

Windows Server
2008

Microsoft SQL Server 2005

Windows 7 Pro

Windows Server
2008

Microsoft SQL Server 2005

Windows Vista
Business

Windows Server
2008

Microsoft SQL Server 2005

Windows XP Pro

Windows Server
2008

Microsoft SQL Server 2005
Express

Windows 7 Pro

Windows Server
2008

Microsoft SQL Server 2005
Express

Windows Vista
Business

Windows Server
2008

Microsoft SQL Server 2005
Express

Windows XP Pro

Windows Server
2008

Oracle Database 119

Windows 7 Pro

Windows Server
2008

Oracle Database 11g

Windows Vista
Business

Windows Server
2008

Oracle Database 119

Windows XP Pro
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Windows Server
2008

Oracle Database 10g

Windows 7 Pro

Windows Server
2008

Oracle Database 10g

Windows Vista
Business

Windows Server
2008

Oracle Database 10g

Windows XP Pro

Windows Server
2008

Microsoft SQL Server 2008

Windows 7 Pro

Windows Server
2003

Microsoft SQL Server 2008

Windows Vista
Business

Windows Server
2003

Microsoft SQL Server 2008

Windows XP Pro

Windows Server
2003

Microsoft SQL Server 2008
Express

Windows 7 Pro

Windows Server
2003

Microsoft SQL Server 2008
Express

Windows Vista
Business

Windows Server
2003

Microsoft SQL Server 2008
Express

Windows XP Pro

Windows Server
2003

Microsoft SQL Server 2005

Windows 7 Pro

Windows Server
2003

Microsoft SQL Server 2005

Windows Vista
Business

Windows Server
2003

Microsoft SQL Server 2005

Windows XP Pro

Windows Server
2003

Microsoft SQL Server 2005
Express

Windows 7 Pro

Windows Server
2003

Microsoft SQL Server 2005
Express

Windows Vista
Business

Windows Server
2003

Microsoft SQL Server 2005
Express

Windows XP Pro

Windows Server
2003

Oracle Database 11g

Windows 7 Pro

Windows Server
2003

Oracle Database 119

Windows Vista
Business
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Windows Server Oracle Database 11g Windows XP Pro
2003

Windows Server Oracle Database 10g Windows 7 Pro
2003

Windows Server Oracle Database 10g Windows Vista
2003 Business
Windows Server Oracle Database 10g Windows XP Pro
2003

TERMINAL SERVICES ARCHITECTURE
Minimum Hardware Requirements

Same minimum client station and database server requirements as for
Conventional Client/Server Architectures.

For the Microsoft Terminal Services Server itself, the primary limiting
factor is RAM. Approximately 25MB of RAM are consumed by each
Remote Desktop launch of WinSPC. If a Microsoft Terminal Services
server has 2GB of available RAM, then, it could potentially host 80
simultaneous user sessions. Additional sessions could be hosted by
increasing RAM or using server clusters.

Beyond RAM, the minimum hardware requirements for the Microsoft
Terminal Services server are:

= Server Class processor — 800MHz

= 200MB available local hard disk space (beyond operating system
recommended space)

= VGA monitor and video adapter
= Keyboard
= Mouse or other pointing device

Terminal Services
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= CD-ROM or DVD-ROM drive

NOTE: One matter that bears mention but doesn’t qualify as a minimum
requirement is the Microsoft Terminal Services server’s number of
CPU cores. It is possible that, even with sufficient RAM, server
performance could degrade unacceptably once a certain volume of
simultaneous sessions is reached. It isn’t practical to state what this
volume is because it depends in part on how active those sessions
are. A reasonable starting allowance would be 10 sessions for each
CPU core.
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Recommended Platforms

The operating system for the Microsoft Terminal Services server must
be Windows Server 2003 (with Service Pack 1) or newer. Other than
this, the recommended platforms for a Microsoft Terminal Services
architecture are the same as those listed above for a conventional
client/server architecture.

How ToO ESTIMATE DATABASE STORAGE REQUIREMENTS

This estimation procedure applies equally to conventional client/server
and Microsoft Terminal Services architectures.

1. Multiply the average subgroup size by 37. (E.g. 5x37=185.)

2. Multiply the average percentage of subgroups in violation by 66.
(E.g. 2%x66=1.32.)

3. Multiply the average number of tag values per subgroup by 17.4.
(E.g. 4x17.4=69.6.)

4. Add the products from the above three steps. (E.g.

185+1.32+69.6=255.92.)

Add 141.88 to the sum from step 4. (E.g. 141.88+255.92=397.80.)

6. Multiply the sum from step 5 by the average number of subgroups
collected per day. (E.g. 397.80x10,000=3,978,000.)

7. Divide the product from step 6 by 1,000,000. (E.g.
3,978,000/1,000,000=3.978.)

The answer you get from step 7 is the number of MB of disk space you
can expect to be consumed per day of WinSPC operation.

o1

THIS COMPLETES APPENDIX G.
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APPENDIX H: CONSIDERATIONS
REGARDING VISTA AND
WINDOWS 7

By taking two considerations into account, WinSPC can be deployed
and fully used on client stations running Vista (i.e. Microsoft Vista
Business) or Windows 7 operating systems. The first consideration
concerns User Account Control and affects all Vista and Windows 7
stations. The second consideration concerns database server
connections and affects only implementations consisting of a
Microsoft SQL Server 2005 database server on a Windows Server
2003.

CONSIDERATION REGARDING USER ACCOUNT CONTROL (UAC)

UAC is a security control in both Vista and Windows 7. When
enabled, it precludes WinSPC users from:

= Upgrading WinSPC.
= Exporting text files of data or specifications.
= |nstalling Custom Web Reporter.

= Collecting data from an OPC server when that server is running on
a computer different from the WinSPC client using it to collect
data and the WIinSPC client has the Use Data Advise option
enabled.

To be able to perform these functions, with the exception of the final
one, UAC must be disabled. For the final function, while disabling
UAC certainly permits it to be performed, it is also possible that your
network administrator, depending on your network security, may be
able to configure DCOM settings on your client and OPC server so
that it can be performed with UAC enabled.
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The procedure for disabling UAC in Windows 7 is:

1. Log into the Windows 7 client station as a local administrator.

2. From the Control Panel click User Accounts.

3. Inthe User Accounts prompt that appears, click User Accounts.
4

In the Make Changes to Your User Account Control Settings
prompt, click Change User Account Control Settings.

5. If a prompt appears asking whether you want to allow the UAC
Settings program to make changes to your computer, click Yes.

6. Inthe User Account Control Settings prompt that appears, drag
the vertical slider to the Never Notify position, which is lowest
position possible.

7. If a prompt appears asking whether you want to allow the UAC
Settings program to make changes to your computer, click Yes.

8. Click OK.

9. Restart your computer.

The procedure for disabling UAC in Vista is:

1. Log into the Vista client station as a local administrator.
2. From the Control Panel click User Accounts.

3. Inthe User Accounts prompt that appears, click Turn User
Account Control on or off.

4. 1If a Windows needs your permission to continue message appears,
click the Continue button.

5. Inthe Turn User Account Control On or Off prompt, uncheck
the Use User Account Control (UAC) to help protect your
computer check box.
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6. Click OK.

7. When the message indicating your computer must be restarted
appears, click Restart Now.

CONSIDERATION REGARDING MICROSOFT SQL SERVER 2005
DATABASE SERVER ON WINDOWS SERVER 2003

When a WinSPC client running Vista or Windows 7 connects to a
Microsoft SQL Server 2005 database server and that database server is
running on a Windows Server 2003 operating system, WinSPC may
on occasion display the following error:

General SQL error. Possible network error. Write to SQL Server
failed. General network error. Check your documentation.

Modifying a particular registry key resolves this issue.

WARNING: Please consult your network administrator prior to
completing the below procedure. Modifying the registry
key referred to disables one of Windows Server 2003’s
security measures.

1. Log into Windows Server 2003 as an administrator.

2. Using the Regedit utility, Navigate to the following registry key:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Ser
vices\Tcpip\Parameters.

3. Tothis key, add the following DWORD value:
= Name: SynAttackProtect
= Value: 0

4. Restart the Windows Server 2003 machine.
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THIS COMPLETES APPENDIX H.
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